
Part 3: Training and Practical Guides 

Overview 
 

 
In this Part This Part covers the following topics 
 

Topic See Page 
Section 1: Trainer's Guide 3-1-1 
Section 2: Interviewer's Guide 3-2-1 
Section 3: Guide to Physical Measurements (Step 2) 3-3-1 
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Section 1: Trainer's Guide 

Overview 

 
Introduction The trainer's guide provides guidance on how to plan, prepare for and deliver 

training to the data collection team, data entry team and data analyst. 

 
Intended 
audience 

This section is designed for use by people that fulfil the following roles: 
 
• STEPS Site Coordinator 
• data collection team supervisor 
• data entry supervisor 
• data analyst. 

 
Purpose The purpose of the training is to: 

 
• explain the rationale of the STEPS surveillance 
• ensure a uniform application of the STEPS surveillance materials 
• motivate interviewers and survey staff 
• ensure good overall quality of data  
• ensure useful and meaningful results are reported. 

 
In this section This section covers the following topics: 
 

Topic See Page 
Training Courses 3-1-2
Training Preparation 3-1-4
Training Lesson Plan: Data collection team 3-1-7
Training Lesson Plan: Data entry staff 3-1-11
Training Lesson Plan: Data analyst 3-1-14
Training Delivery Tips 3-1-15
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Training Courses 

 
Introduction A combination of formal classroom training and hands-on experience is 

required to adequately train staff that have been recruited to work on STEPS 
survey. 

 
Training 
courses to 
follow 

The following three separate trainings will need to be conducted to ensure 
each member of the recruited teams and the data analyst receives appropriate 
training: 
 
• interviewer training 
• data entry training 
• data analysis training. 

 
Training course 
phases and 
durations 

The table below provides a guideline for each of the training phases and 
durations to cover the material and train participants to a good level of 
understanding and proficiency in their specific area.  Three training courses 
are provided, one for each team and one self-study schedule for the data 
analyst: 
 
• data collection 
• data entry 
• data analysis. 

 
Training phases Recommended durations 

Classroom training 2-4 days 
Pilot test 1 day 
Refresher prior to start (optional) 1 day 
Total  4-6 days 

 
Notes:  Refresher training is optional but may be useful if: 
• there is a significant gap between when the classroom training was 

completed and the start of the survey, or 
• the pilot test shows up lots of knowledge gaps and some aspects of the 

training need to be repeated.  

 
Training 
content and 
module 
durations 

Suggested course content and training delivery timeframes for each module of 
learning are provided in the lesson plans below. 
 
These may need adaptation for individual sites, for example some modules in 
the data entry course may be shorter if participants already have relevant 
experience, or longer if the participants have not used computers before. 

Continued on next page 
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Training Courses, Continued 

 
Participation The training courses are intended primarily for members of the respective 

teams.  To help with coordination, you may wish to consider having the team 
supervisors attend one or more of the training courses.   
 
It is recommended that the statistical adviser complete at minimum the first 
day of the training for the data analyst and, if possible, he/she should attend 
the data entry and data collection trainings as well. 
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Training Preparation 

 
Introduction Training preparation involves the following tasks: 
 

Task Description 
1 Finding and setting up a suitable training room 
2 Scheduling training sessions 
3 Coordinating training tasks and events 
4 Preparing, printing and distributing training materials 
5 Informing participants about course content, date, time and location 

details and prerequisite requirements 
 

Note: Each of these tasks is described further below. 

 
Training 
location 
requirements 

A training room will need to be located and arrangements made for use over a 
three to four week period to train all recruited members of the data collection 
and data entry teams as well as the data analyst. 
 
The room (or rooms) should be able to accommodate the number of people 
being trained, the number of trainers or facilitators, plus several extras, at a 
time. 

 
Requirements for Details 

All rooms • tables 
• chairs 
• blackboard, white board or flip chart 
• chalk, marker pens, or crayons 
• multi media projector (optional)  
• overhead projector (optional) 

Data collection • sufficient room to practice taking physical 
measurements 

• props to help with scenarios 
Data entry • computers (minimum 1:2 ratio) loaded 

with site-specific data entry software 
(EpiData) 

Data analysis • computer loaded with site-specific data 
analysis software (Epi Info) 

 
Scheduling 
training 
sessions 

You will need to schedule training sessions for data collection and data entry 
staff in advance to ensure each course is well attended and training is 
provided to all team members before the survey begins. 
 
Provide each participant with a letter confirming the course agenda, including 
date and place of training. 

Continued on next page 
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Training Preparation, Continued 

 
Training 
coordination 

You may need to plan for and arrange some or all of the following 
coordination tasks: 
 
• selection of a pilot community; 
• order and arrange teas/coffee and lunches for classroom training sessions; 
• book accommodation and arrange transport (if necessary); 
• develop and set up exercises to be used during classroom training; 
• determine, develop and compile training and reference materials that will 

need to be used by course participants; 
• obtain maps or list of households. 

 
Preparing 
materials 

Prior to training sessions, you will need to print out one set per participant of 
the relevant materials from the STEPS Manual.  You may choose to print the 
whole manual for each participant.  If you wish to print only relevant selected 
sections, use the table below as a guide.  

 
Team Training Topics Part, Section 

Introduction Part 1, Section 1 
Planning and Preparing a STEPS Survey Part 2, Section 1 
Preparing the Sample Part 2, Section 2 
Preparing a STEPS Site Part 2, Section 3 
Interviewer's Guide Part 3, Section 2 
Guide to Physical Measurements Part 3, Section 3 
Data Collection Part 4, Section 1 
STEPS Instrument Part 5, Section 1 
Question-by-Question Guide Part 5, Section 2 
Show Cards Part 5, Section 3 

Data Collection 

Interview, Blood Collection and Data 
Entry Forms 

Part 6, Section 2 

Introduction Part 1, Section 1 
Preparing the Data Entry Environment Part 2, Section 4 
Data Entry Guide Part 3, Section 5 
Data Entry Part 4, Section 2 
STEPS Instrument Part 5, Section 1 
Question-by-Question Guide Part 5, Section 2 

Data Entry 

Interview and Data Entry Forms Part 6, Section 2 
Introduction Part 1, Section 1 
Preparing the Sample Part 2, Section 2 
Preparing the Data Analysis 
Environment 

Part 2, Section 5 

Data Analysis 

Data Analysis Guide Part 3, Section 6 

Continued on next page 
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Training Preparation, Continued 

  
Preparing materials (cont.) 

 
Team Training Topics Part, Section 

Data Analysis Part 4, Section 3 
Reporting and Disseminating Results Part 4, Section 4 
STEPS Instrument Part 5, Section 1 
Question-by-Question Guide Part 5, Section 2 

Data Analysis 
cont. 

Interview and Data Entry Forms Part 6, Section 2 

 
Participant 
preparation 

Prior to attending a training session, all training participants will need to study the 
STEPS Instrument and appropriate sections in the STEPS Manual.  

 



Training Lesson Plan: Data collection team 

 
Introduction The following lesson plan is a guide for people responsible for delivering the data collection team training.  This may be the STEPS 

Site Coordinator or the data collection team supervisor. 
 

Training topics Duration Section 
reference 

Outcomes or competencies Exercises 

Day 1 
Introductions, warm up, agenda and 
expectations 

9.00-10.00 3-1-15 Establish a new team, set expectations 
and course agenda. 

 

Overview and Rationale of the WHO 
STEPwise approach to chronic disease 
risk factor surveillance 

10.00 -12.30 1-1 Understand chronic diseases and their 
key risk factor, importance of 
surveillance framework, get an 
overview of what STEPS is and how it 
works. 

 

Lunch 
The data collection team 14.00 - 14.30 1-2 

3-2-3 
4-1-2 

Understand staff core roles and 
responsibilities as well as the 
organization of the data collection 
team. 

 

Sampling 14.30 - 15.30 2-2  
 

Understand how households are being 
sampled, understand the imperative of 
a random sample. 

Talk through how the sample 
is being selected.  
Consider possible concerns 
or questions & how they 
could be handled. 
Explain that interviewer must 
stick to sample and not select 
a neighbour if their selected 
person is not at home. 

Approaching selected households 15.30 - 16.30 4-1-7 
6-2-2 

Competently follow procedures for 
approaching households. 

Scenarios, moving from 
simple to more difficult. 
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Day 2 
Review of day 1, warm up  9.00-9.30  Recognize previous day’s learning.  

Identify and handle any queries.  
 

The Kish method 9.30-10.00 2-2-25 
6-2-11 

Understand how an individual within 
selected households is selected, know 
how to use the Kish method. 

Explain the Kish method, 
participants to use the Kish 
method in practice exercises. 

Interview tracking 10.00-11.00 2-2-28  
4-1-12 
6-2-12 

Understand the importance of  
interview tracking (e.g., tracking of 
non-response) and know how to use the 
Interview Tracking Form. Understand 
how the information from the Interview 
Tracking Form will be used in data 
analysis. 

Talk through examples on 
how to fill in the Interview 
Tracking Form. 

Informing participants and obtaining 
consent 

11.00-12.00 4-1-9 
4-1-11 
6-2-3 
6-2-6 

Know why and how to inform 
participants in detail.  Understand 
ethical considerations and their 
relevance for interviewing.  Follow 
guidelines to obtain consent. 

Practice how to inform 
participants and obtain 
consent.  Scenarios with e.g. 
reluctant, objecting, unwell, 
or over-busy respondents. 

Lunch 
Interview skills 13.30-14.30 3-2-4 Understand and demonstrate good 

interview practices. 
Use scenarios to demonstrate 
how responses can be swayed 
by different interview 
techniques. 

STEPS Instrument, Question-by-Question 
Guide and show cards  

14.30-16.00 3-2-10 
5-1 
5-2 
5-3 

Understand the Instrument, the 
different risk factors and what they aim 
to measure, response options (including 
don't know and refuse), skip 
instructions and show cards.  
Understand how to use the Question-
by-Question Guide and the show cards. 

Talk through the STEPS 
Instrument and Question-by-
Question Guide section by 
section. 
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Day 3 
Review of day 2, warm up 9.00-9.30  Recognize previous day’s learning.  

Identify and handle any queries. 
 

Recording information and checking 
paperwork 

9.30 - 10.30 4-1-14 Understand how to record information 
on the STEPS Instrument and to do all 
paperwork properly.   

Explain how to record 
information on the STEPS 
Instrument.   

Collecting demographic and behavioural 
risk factor information 
 (Step 1). 

10.30 - 12.30 3-2 Understand the questions, know how to 
clarify.  Record responses clearly and 
accurately, deal with different people, 
resolve inconsistencies and incomplete 
Instruments. 

Explain how to collect 
demographic and behavioural 
risk factor information, 
demonstrate various 
difficulties and strategies. 
Practice interviews. 

Lunch 
Collecting demographic and behavioural 
risk factor information 
 (Step 1), cont. 

14.00-15.00 3-2 Understand the questions, know how to 
clarify.  Record responses clearly and 
accurately, deal with different people, 
resolve inconsistencies and incomplete 
Instruments. 

Explain how to collect 
demographic and behavioural 
risk factor information, 
demonstrate various 
difficulties and strategies. 
Practice interviews. 

Taking and recording physical measures 
(Step 2) 

15.00 - 16.30 3-3 Assemble equipment and supplies for 
Step 2 measurements. Measure blood 
pressure, height, weight, waist and hip 
circumference (if applicable). 
Clearly and accurately record 
participant results. 

Learn and practice on team 
members, all participants' 
measure independently then 
compare results. 
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Day 4 
Review of day 3, warm up 9.00-9.30    
Taking and recording physical measures 
(Step 2), cont. 

9.30-11.00 3-3 Assemble equipment and supplies for 
Step 2 measurements. Measure blood 
pressure, height, weight, waist and hip 
circumference (if applicable). 
Clearly and accurately record 
participant results. 

Learn and practice on team 
members, all participants' 
measure independently then 
compare results. 

Completing the Participant Feedback 
Form (Step 2) 

11.00-12.00 4-1-16 
6-2-8 
6-2-10 

Understand how to record information 
on the Participant Feedback Form.  
Know how to use the BMI 
Classification Chart.  

Explain how to record 
information on the 
Participant Feedback Form 
and how to use the BMI 
Classification Chart. 

Lunch 
Referrals and procedures for biochemical 
measures (Step 3) 

13.30 - 14.30 3-4 
4-1-17 
6-2-13 
6-2-14 

Know how to make appointments for 
those selected for Step 3, know what 
interviewees need to know for Step 3, 
know how to use forms related to Step 
3. 

Explain referrals and 
procedures related to 
biochemical measures. 

Check-list for equipment and supplies, 
checking paperwork 

14.30-15.30 2-2-28 
2-3-4 
4-1-6 

Know what documents, equipment and 
supplies are needed for field work.  
Know how to organize the material. 

Explain all equipment, 
supplies and documents and 
how to organize the material. 

Preparing pilot test, 
Review of most important issues that 
arose during training, discussion 

15.30-16.00 4-1 
2-1-21 

Clarification of final questions before 
interviewers do the pilot test.  

Wrap-up, clarify all questions 
that have not been answered 
during the training. 

Day 5 
Pilot test 9.00 - 16.00 2-1-21 

 
Major aspects of data collection 
thoroughly tested. Identify weaknesses 
or failures in current systems and 
processes.  

Go to a residential area, with 
a pre-determined sampling 
plan.  Participants do a 
complete run-through of 
whole data collection 
process.  

At a later date 
Refresher 9.00 - 16.00    
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Training Lesson Plan: Data entry staff 

 
Introduction The following lesson plan is a guide for people responsible for delivering the data entry staff training.  This will usually be the 

data entry supervisor. 
 

Training topics Duration Section 
reference 

Outcomes or competencies Exercises 

Day 1 
Introductions, warm up, agenda and 
expectations 

9.00 - 10.00 3-1-15 • establish new team 
• set expectations 
• review course agenda 

 

The data entry team (office setup and 
workflow) 

10.00 - 11.00 3-5-5, 4-2-2 • understand main roles and 
organization of personnel 

• discuss data privacy issues 
• understand office workflow 

Label computers, assign staff 
to computers for 1st & 2nd 
keying, create folders and 
coversheets for each 
computer. 

Computer basics 11.00-12.00 3-5-3 • familiarization with computer parts 
and terms 

• address ergonomic considerations 
• review computer basics: logging 

on & off, using the keyboard and 
mouse, printing, etc. 

Have staff sit at assigned 
computer for 1st keying and 
have them log on, take a 
small tour, create a text 
document, print, log off. 

Lunch 
Data flow and the data entry process 14.00 - 15.30 3-5-5, 4-2-6 • understand overall data entry 

process 
• understand importance of good 

data flow in the office 
• review how instruments will flow 

through office 
• review data tracking forms 
• practice filing and retrieving 

instruments 

Distribute copies of the Data 
Entry Tacking Form and 
Data Entry Log and show 
how to fill them out. 
 
Use a set of dummy 
instruments with only a 
participant ID completed to 
practice distribution, flow 
and tracking of instruments. 
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Training topics Duration Section 
reference 

Outcomes or competencies Exercises 

Consulting your supervisor  
 

15.30 - 16.00 3-5-7 • understand when to ask for 
clarification from supervisor 

• review roles and responsibilities of 
each team member 

• review data entry rules and 
guidelines 

 

Day 2 
Review, warm up, agenda and 
expectations 

9.00-9.30  • review previous day and today's 
agenda 

 

EpiData templates 9.30-10.30 2-4-8, 3-5-10 
 

• understand the purpose of different 
templates and the file structures 

Relate site-specific 
instrument to the data entry 
templates. 

Using EpiData (data entry software) 10.30 - 12.30 3-5-9, 3-5-10 • review how to open and navigate 
EpiData and how to open a data 
entry template in EpiData 

• review steps in process of 1st 
keying, 2nd keying preparations, 
and 2nd keying 

• review how to create consistency 
reports 

Have staff practice on 
assigned computer opening 
and navigating EpiData and 
opening a data entry template 
for data entry.  Have trainer 
demonstrate creation of 
consistency report on one 
computer with entered data.  

Lunch 
Rules and guidelines for data entry 14.00-14.30 3-5-7 • understand and demonstrate rules 

and guidelines for data entry 
• be able to identify and correctly 

handle any problems that may arise 
during data entry 

Present several examples of 
potential data entry problems 
(e.g. missing pages, illegible 
writing, out-of-range 
responses) and review as a 
group how each should be 
handled. 
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Training topics Duration Section 
reference 

Outcomes or competencies Exercises 

First and second keying data entry 14.30 - 15.30 3-5-10 • review in-depth how to do 1st 
keying and prepare for 2nd keying 

• assign staff 2nd keying computers 
and review how and when staff 
should swap computers 

• review in-depth how to do 2nd 
keying (data validation) 

Have staff practice on 
assigned computer: 
completing first key  and 
preparing for 2nd keying 
using a small number of 
completed dummy 
instruments. 
 
Have staff change seats so 
they are seated at computers 
for 2nd keying.  Have staff 
practice 2nd keying on these 
computers. 

Backing up data 15.30 - 16.00 3-5-16 • explain need for file protection and 
safety 

• demonstrate back-up procedures 

Have staff practice backing 
up entered data on assigned 
computer. 

Day 3 
Pilot testing 9.00 - 16.00 2-4-19, 3-5-17 • thoroughly review entire data entry 

process with set of completed 
dummy instruments 

• gain further practice handling 
instruments containing errors 

• identify any difficulties faced and 
discuss how to handle them 

See 3-5-17 for exercise 
description. 

At a later date 
Refresher training Weekly 

meetings 
 • review procedures for processing 

and tracking all instruments 
• identify weaknesses/problems in 

current system and devise solutions
• check consistency reports 
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3-1-14 

Training Lesson Plan: Data analyst 

 
Introduction The following Lesson Plan is a self-study guide for the data analyst.   

Part 3: Tr

 
Training topics Duration Section reference Outcomes or competencies Exercises 

Day 1 
Become familiar with relevant sections 
of the STEPS Manual. 

9.00 - 10.30 2-2, 2-5, 3-6, 4-3 • understand what information is 
available and where it is located 

 

STEPS Instrument 10.30 - 11.30 5-1, 5-2 • become familiar with the site-specific 
instrument and the generic STEPS 
Instrument 

• become familiar with types of data 
collected and generic question codes 

Print out both 
instruments and identify 
differences. 

Preparing the fact sheet and data book 11.30-12.30 4-4-9, 4-4-12, 6-3 • become familiar with the Fact Sheet 
and Data Book 

• develop a basic understanding of how 
to complete these documents 

Print out and review Fact 
Sheet, Fact Sheet 
Analysis Guide and Data 
Book. 

Lunch 
Sample design and scope of STEPS 
survey and weighting your survey data 

13.00 -15.00 2-1-5, 2-2, 4-3-19 
 

• understand the sample design and 
scope of the survey 

• understand how to create weight and 
sample design variables for a weighted 
analysis 

Review sections of 
manual listed and review 
all materials related to 
sample design of survey 
(e.g. Implementation 
Plan). 

Introduction to Epi Info (data analysis 
software) and accessing survey data 

15.00-16.00 3-6 • install Epi Info  
• perform basic tasks in Epi Info using 

Part 3, Section 6 as a guide 

Create small dummy data 
set and practice basic 
commands in Epi Info. 

Day 2 
In-depth Epi Info training 9.00-17.00 Epi Info Training 

Guide 
• complete all exercises in Epi Info 

Training Guide 
• perform more advanced tasks in Epi 

Info 

Follow exercises in Epi 
Info Training Guide 
using training files 
available from STEPS 
CD or STEPS website. 
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Training Delivery Tips 

 
Introduction The training delivery tips below may be useful for those that have been 

assigned the role of training, but are not in fact trained trainers. 

 
Introductions 
and warm up 

Before you start the training, it is important for team development to 
introduce yourself and find out a little about the people in the room.  Use the 
table below to help with the introductions. 

 
Step Action 

1 Introduce yourself and any other co-trainers to the participants. 
2 If you don’t already know everyone in the room, or they don’t 

know each other, get each participant to briefly introduce 
themselves (or a person beside them). 

3 Ask participants and adapt according to the class: 
 
• what they understand by 'chronic noncommunicable disease risk 

factors'; 
• what they think the biggest chronic disease health issues are in 

their country or area; 
• in what ways do those diseases impact on the health and welfare 

of the people in their communities.  
 
Note: Write the responses on a board. Acknowledge that there is 
not necessarily a 'correct' answer, it varies by time and community. 
Encourage discussion so you can gauge the level of understanding 
that the staff already have. The staff can begin to learn on what 
they and their colleagues will be working. 

4 Ask participants if they have any questions or topics they would 
really like to have covered in the training. 
 
Note: Write the responses on the board and try and answer them 
during the training course. 

 
Course agenda 
and setting 
expectations 

Participants will need to know what to expect in terms of training content, 
how long it will take and what is expected of them during the course.  Use the 
table below (and lesson plans) to help explain the agenda and set 
expectations: 

 
Step Action 

1 Explain the aim of the training. 
2 Outline what will be covered. 
3 Tell them how long the training will take. 
4 Explain what is expected of them during training. 

Continued on next page 
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Training Delivery Tips, Continued 

 
Using material The STEPS Manual has been structured into modular sections that can be 

easily extracted and recompiled to provide customised manuals for training. 
 
The manual content has been designed for use as both training material and in 
the field reference. 

 
Exercises You will need to create exercises that: 

 
• are relevant to the local environment 
• support the training material 
• work through typical problems and issues that are likely to be encountered 
• allow for hands on practice. 

 
Encouraging 
participation 

The course is not about how much you as the trainer fill it with content, but 
how much the participants take away in new learning and understanding of 
skills.  
Continually encourage all attendees to participate.  Use the table below for 
guidance. 

 
Topic Guidance 

Comfort zones Acknowledge that participants may be asked to do 
things out of their comfort zone (particularly in the 
interviewing course where scenarios are an important 
part of training). 

Criticism Ensure participants are not criticised or demoralised 
when offering comments and questions. 

Experience Develop or build on participants own experiences and 
understandings. 

Fears Recognize fears and concerns and offer strategies to 
handle them. 

Support Offer praise when appropriate and support when 
participants demonstrate feelings of inadequacy or 
difficulty. 

Strengths and 
weaknesses 

Assure everyone that we all have strengths and 
weaknesses and that they have been selected as a team, 
with skills that complement those of others. 

Team work Encourage teams to work together and communicate 
well. 

Being self reliant Once the survey starts, there will not always be an 
"expert" available to answer questions.  Participants 
must understand enough to be self reliant and know 
when to seek advice or help from others. 

Continued on next page 
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Training Delivery Tips, Continued 

 
Beginning and 
ending sessions 

It is always helpful to introduce each session with an introduction covering: 
 
• the previous work that builds a foundation for this session  
• the content and purpose of the session 
• briefly the resources and format to be used. 
 
At the end of the session, summarise: 
 
• what topics and skills have been covered; 
• whether that is the end of that topic or a future session will cover further 

material; 
• acknowledge areas of good progress, but also areas where further work 

will be required. 

 
Handling 
problems and 
participation 
issues 

Use the guidance in the table below to help with some typical problems 
encountered in the training environment. 

 
Problem/ situation Guidance 

Late arrivals Recap briefly what has just been covered and 
politely make it clear that you want all participants 
to be punctual. 

Interruptions Remain patient at all times. 
Participant does not 
seem to follow and 
understand. 

Show patience and understanding.  Repeat the 
point/topic in a different way and then ask if the 
participant understands better. 

A participant is 
dominating the 
sessions, making it 
difficult for others to 
participate and learn. 

First try commenting during discussions that you’d 
like everyone to contribute, even use the phrase 
"let’s hear from someone else this time".  
If that does not achieve anything, take the staff 
member aside during a break and suggest that others 
also need to participate. Give a little praise, if 
warranted, about their grasp of the topic, but state 
that, as the trainer, you need to hear from other 
participants, too. 

Participant is not 
keeping up with the 
others, or appears 
unable to "engage". 

During a break, seek out the staff member to see 
whether anything is wrong, or if they are finding 
anything particularly difficult.  If so, a short "catch-
up" session may help.  If the participant is unwell or 
troubled it might be best if they leave. 

Continued on next page 



Part3: Training and Practical Guides  3-1-18 
Section: 1 Trainer's Guide  WHO STEPS Surveillance 
Last Updated: 11 June 2008 

Training Delivery Tips, Continued 

 
Celebrating 
milestones 

Within the context of the training course, as in the conduct of the survey 
itself, recognize milestones to encourage the participants and to help develop 
a sense of "team-ship".   
 
Think particularly of those who may be regarded as outsiders in any way – 
perhaps they are from out-of-town, are not known to other members of a 
group, or are of a different language group or cultural background – who may 
be more hesitant to participate.   
 
You may like to have markers of effort, mastery, achievement or other 
contribution - use your imagination to select small gifts, snack food treats or 
certificates to award to participants. 
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Section 2: Interviewer's Guide 

Overview 

 
Introduction The quality of STEPS surveillance results and their usefulness for intra- and 

intercountry comparisons largely depends on the quality of the interviews.  

This section provides generic guidelines for interviewers.  It does not cover 

step-by-step instructions on approaching households, informing participants 

and obtaining consent.  This is covered in Part 4, Section 1.  The following 

sections in this part, Section 3 and Section 4, give information on how to 

undertake the physical and biochemical measurements (Step 2 and 3). 

 
Intended 

audience 
This section is designed for use by those fulfilling the following roles: 

 

• interviewers 

• data collection team supervisors 

• STEPS Site Coordinator 

• data entry staff. 

 
What you will 

learn 
In this section, you will learn: 

 

• the structure of the data collection team 

• how to interview participants 

• how to complete participants' instruments 

• how to use the Question-by-Question Guide 

• how to use the show cards. 

 
Learning 

outcomes  
The learning outcome of this module is to conduct consistent and effective 

interviews and record accurate data. 

 
Instructional 

material 
For the full process of an interview from knocking at the door to leaving the 

household, see Part 4, Section 1. 

 
Other data 

collection 

materials 

This Guide is to be used in conjunction with the following sections in the 

STEPS Surveillance Manual.  These sections provide full instructional 

material on the following topics. 

 

Topic Part, Section 

Preparing a STEPS site Part 2, Section 3 

Guide to Physical Measurements Part 3, Section 3  

Guide to Biochemical Measurements Part 3, Section 4 

Data Collection Part 4, Section 1 

Continued on next page 
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Overview, Continued 

 
In this section This section covers the following topics: 
 

Topic See Page 

Data Collection Team 3-2-3 

Interview Skills 3-2-4 

Completing the STEPS Instrument 3-2-10 

Question-by-Question Guide 3-2-12 

Show Cards 3-2-13 

Demographic Information (Step 1) 3-2-14 

Behavioural Measurements (Step 1) 3-2-15 
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Data Collection Team 

 
Introduction You will be assigned to work with a team of other interviewers in a specified 

area for the duration of data collection. 

 
Interviewer 

identification 
Each interviewer will have a unique ID.    

 

This Interviewer ID will be filled in on all data collection forms (see Part 2, 

Section 2). 

 
Supervision Each team will work with a supervisor.  The supervisor is responsible for: 

 

• tracking your progress 

• ensuring instruments are completed correctly 

• keeping data collection to the specified timeframe  

• handling any issues you encounter. 

 

Note:  For further details on the supervisor's role, please see Part 4, Section 1. 
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Interview Skills 

 
Introduction The STEPS interview is about finding out and recording a list of facts and 

behaviours relating to selected participants.  

 

The participant needs to feel comfortable about the survey and can refuse to 

be interviewed as participation is voluntary.  Your interview should therefore 

be as natural as possible and conducted politely, like a normal conversation. 

 
Behaviour and 

tact 
The table below provides guidelines on appropriate behaviour during an 

interview: 

 

Behaviour Guidelines 

Respect confidentiality Maintain the confidentiality of all information you 

collect. 

Respect participants 

time 

You are asking participants for their time so be 

polite and prepared to explain. 

Tact If you feel that a person is not ready to assist you, 

do not force them but offer to come back later. 

Friendly disposition Act as though you expect to receive friendly co-

operation and behave accordingly. 

Body language Maintain good eye contact and adopt appropriate 

body language. 

Pace of interview Don't rush the interview. Allow the participant 

enough time to understand and answer a question. 

If pressured, a participant may answer with 

anything that crosses their mind. 

Patience Be patient and polite at all times during the 

interview. 

Acceptance No matter what the responses to questions, do not 

be judgemental of a participant’s lifestyle.  

Expression of any criticism may lead to refusing or 

concealing important information. 

Appreciation Thank them for their help and cooperation. 

Continued on next page 
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Interview Skills, Continued 

 
Asking 

questions 
The table below provides guidelines for asking questions in an interview: 

 

Topic Guidelines 

Issues relating to 

chronic diseases and 

their risk factors 

Do not discuss or comment on issues relating to 

chronic diseases and their risk factors.  Participants 

may not give correct answers to the questions but 

give the answers they think the interviewer is 

looking for. 

Right or wrong 

answers 

Point out that there are no right or wrong answers 

and that the interview is not a test. 

Biased answers Ask your questions according to guidelines given 

in the Question-by-Question Guide to avoid biased 

answers and ensure comparability of data (see Part 

5, Section 2). 

Read all options All options must be read to the participant except 

for Don't know/Don't remember, Refused, and 

Other. 

Reading questions Questions should be read:  

• as they are written in the text; 

• slowly and clearly emphasizing key words in 

bold; 

• in a pleasant voice that conveys interest and 

professionalism; 

• entirely to make sure the participant has heard it 

completely. 

 

Do not change the: 

• wording  

• order of the questions. 

Making assumptions Don't make assumptions about the participants’ 

answers with comments such as "I know this 

probably doesn’t apply to you, but…".  

 

This practice may prevent accurate and unbiased 

information. 

Continued on next page 
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Interview Skills, Continued 

 
Providing 

clarification 
You may need to provide clarification when the participant: 

 

• is unable to answer the question asked; 

• does not seem to understand the question and gives an inappropriate reply; 

• does not seem to have heard the question; 

• is taking a long time to answer the question and hesitates; 

• asks about a specific part of the question to be repeated (it is acceptable to 

repeat only that part); 

• asks for one option to be repeated (read all options again but you may omit 

one option if it has clearly been eliminated by the participant); 

• asks for one term to be clarified (refer to the explanations provided in the 

Question-by-Question Guide). 

 
When to probe 

further 
You will need to probe further to get an appropriate response when the 

participant: 

 

• seems to understand the question but gives an inappropriate response 

• does not seem to understand what is asked 

• misinterprets the question 

• cannot make up his or her mind 

• digresses from the topic or gives irrelevant information 

• needs to expand on what has been said or clarify the response 

• gives incomplete information or an answer is unclear 

• says that he or she doesn’t know the answer. 

Continued on next page 
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Interview Skills, Continued 

 
Common 

responses that 

need probing 

The table below lists some common responses that may need further probing: 

 

If the participant 

replies… 

Then… 

"I don’t know" (DK) Repeat the question. 

"I still don’t know" Probe once before recording (DK), for 

example, ask "Could you give me your best 

estimate". 

"I still don't know" This may mean the participant: 

• is taking time to think and wants to gain 

time; 

• does not want to answer because of personal 

reasons; 

• in fact does not know or has no opinion. 

"Not applicable" (NA) 

 
• ask him/her why the question does not apply 

to him/her; 

• write down NA if it is clear that the question 

is irrelevant. 

 

Notes:   

• Don't know/Don’t remember and Refuse should be used only as an absolute 

last resort. 

 
Probing 

techniques 
The table below provides a few techniques to use when probing further: 

 

 

Technique Guidelines 

Repeat the question The participant may come up with the right answer 

if he/she hears the question a second time. 

Make a pause This gives the participant time to collect his/her 

thoughts and expand on his/her answer. 

Repeat the 

participant's reply 

This is often a very effective way of having the 

participant reflect on the answer he/she has just 

given. 

Use neutral probes Avoid biased responses and probes.   Never give 

the impression that you approve or disapprove 

what the participant says, or that their answer is 

right or wrong.  Instead, if you want more 

information, ask "anything else?", or "could you 

tell me more about…?" 

Continued on next page 
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Interview Skills, Continued 

 
Interruptions Interruptions may occur during an interview.  If they become too long or too 

many, suggest returning at another time to complete the interview.  

 

Take care that even if interrupted or delayed, you should remain patient and 

polite at all times. 

 
Refusal to 

answer 
Some participants may refuse to be interviewed.  Reasons for this are varied 

and differ from one participant to another.  Some participants may not refuse 

outright but may express hesitancy, reservation or hostility.   

 

You will learn to distinguish between refusals (e.g. hesitancy from a definite 

refusal).  Success in obtaining cooperation will depend upon your manner and 

resourcefulness. 

 

Participants must not be forced to respond to the whole interview or to any 

part of the survey process.  However, the more refusals that are made, the less 

representative the survey is of the whole population.   

 
Handling 

refusals 
Be prepared to obtain cooperation from a participant who does not want to be 

interviewed.  In general, be pleasant good-natured and professional and most 

participants will cooperate. 

 

Use the table below to help you handle some refusal situations: 

 

If... Then… 

The participant becomes 

defensive 
• show patience and understanding; 

• provide token agreement and 

understanding of his/her viewpoint, that 

is, saying something like, "I can 

understand that" or "You certainly have 

the right to feel that way"; 

• convey the importance of the survey to 

the participant. 

You may have visited at a bad 

time 

Try again later.   

The participant may have 

misunderstood the purpose of 

the visit 

Try to explain the purpose again. 

You think you may get a "no" Try to leave and suggest coming back later 

before you get a partial or an absolute "no". 

Continued on next page 
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Interview Skills, Continued 

 
Language 

issues 
Be aware that if you use ‘interpreters of convenience’ (such as members of 

the participant’s family or household, the village headman, or domestic staff), 

you may get incorrect data being recorded.  

 

If you don't get sufficient cooperation due to a language barrier, report this to 

your supervisor. 
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  0  5  

Completing the STEPS Instrument 

 
Introduction Once the standard STEPS Instrument has been adapted, translated and printed 

it is ready for use during the survey.   

 

One instrument is to be completed for each participant you interview and 

measure.  All items on the instrument must be completed for the response to 

be valid. 

 
ID codes When the interviewer receives the instruments, the following ID codes and 

information should be filled in already (see Part 2, Section 2, "Preparing Data 

Collection Forms"): 

 

• Cluster ID 

• Cluster name 

• Interviewer ID 

• Participant ID (on each page, first page twice). 

 
Consent, 

Interview 

Language and 

Name 

The second part on the first page of each instrument contains identification 

information, including the participant names.  It is very important that these 

details are kept confidential at all times and you should tell the participant 

that they will be kept confidential. 

 
Core and 

expanded items 
The instrument contains CORE and EXPANDED questions and 

measurements.  You will need to complete both. 

 
Introductory 

statements 
Where a section of items has an introductory statement, read this out to the 

participant before asking the questions in the section. 

 
Entering the 

participant's 

response  

For each item on the instrument, there may be one or more possible 

responses.  Each possible response has an associated number.  You will need 

to circle the appropriate response or fill in the appropriate response in the 

available box for each item.  For example: 

 

Questions Response Code 

24 Do you currently smoke any tobacco 
products, such as cigarettes, cigars or 
pipes? 

Yes 
No 

1 
2   If No,  go to T 6 T1 

Number of servings 

45 How many servings of fruit do you eat on 
one of those days?  (USE SHOWCARD) 

Don't Know 77 

 

└─┴─┘ 

D2 

Continued on next page 
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Completing the STEPS Instrument, Continued 

 
Skip 

instructions 
Skip instructions are located in the response column just next to the response. 

You will need to follow the instructions if the participant responds in a certain 

way to the question.   

 

If you need to record notes, (for example, if the right arm was used instead of 

the left arm to take a blood pressure measurement) insert them in the left hand 

side margin. 

 
"Don't know" 

responses 
The table below shows what to enter as a last resort where the participant 

does not respond with a standard response. 

 

If the participant 

responds with And number of └─┘is 
Then enter 

Don't know 

Don’t remember 

 

└─┴─┘ 
77 

Don't know 

Don’t remember 

 

└─┴─┴─┘ 
777 

Refused  

└─┴─┘ 
88 

Refused  

└─┴─┴─┘ 
888 
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Question-by-Question Guide 

 
Introduction The Question-by-Question Guide (Q-by-Q) is a 'master' version of the 

standard STEPS instrument.  It provides instructions and guidelines for each 

question. 

 

A copy of the Q-by-Q Guide can be found in Part 5, Section 2. 

 
Purpose of the 

Q-by-Q guide 
The purpose of the Q-by-Q Guide is to provide background information, 

explanations and examples of correct information to help interviewers 

accurately complete each instrument with participants. 

 

It is to be used as both a training and data collection tool. 

 
Using the guide Before conducting the interviews, data collection team staff should: 

 

• read the Q-by-Q Guide many times over until you are comfortable 

with the information; 

• practice asking the questions; 

• become thoroughly familiar with the contents of the instrument. 

 
Responding to 

questions for 

clarification 

If participants request clarification about specific questions, use the Q-by-Q 

Guide to help, rather than offering your own interpretations. 
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Show Cards 

  
Introduction Show cards are useful tools to help explain what is meant by some of the 

questions on the Instrument.  To be useful, they must be adapted to local 

settings. 

 
Applicable 

show cards 
For each interview you may need to have show cards that cover the following 

topics: 

 

• list of work status 

• list and/or show cards of tobacco products 

• alcohol consumption (standard drink) 

• diet (typical fruit and vegetables and serving sizes) 

• types of physical activities. 

 

Note:  These show cards can be found in Part 5, Section 3. 

 
Instructions for 

use 
These cards will have been adapted so they are appropriate for your setting. 

 

Use the show cards to: 

 

• help clarify what you mean and what the terms used on the Instrument mean 

• show participants examples of the kind of products you are talking about. 
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Demographic Information (Step 1) 

 
Introduction Accurate core demographic information is essential for analysing and 

reporting on the overall results of the STEPS survey.   
 

If the age and sex of a participant has been missed out, their responses cannot 

be used in the analysis, as most analyses report results that are grouped by 

these criteria. 

 
Core 

demographic 

information 

The core demographic information that is captured with the STEPS 

instrument includes: 
 

• sex 

• age 

• years spent at school. 

 
Dates of birth 

and age 
In some countries, some individuals may not know their exact dates of birth 

and/or age.  In these situations their age has to be estimated.  To estimate 

someone's age, you will need to ask them how old, or at what stage in life 

they were at the time that a number of widely known major local events 

occurred. 

 
Expanded 

demographic 

information 

Expanded demographic information includes: 
 

• highest level of education 

• ethnic/racial group 

• marital status 

• work status 

• household earnings. 

 

Please note that it will be easier for respondents to answer the question on 

work status if a list of work status is used (see Part 5, Section 3 "Show 

Cards". 
 

Some of the expanded demographic questions will have been adapted for 

your site so the terms and phrases make sense to participants in your 

environment, e.g., insertion of country specific examples for work status. 

 
Skip 

instructions 
There are two skip instructions in the demographic information section of the 

STEPS Instrument: 
 

• C2: If date of birth is known, C3 ("How old are you?") can be skipped; 

• C10a-d: If average earnings of the household are known, C11 (income 

quintiles) can be skipped. 
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Behavioural Measurements (Step 1) 

 
Introduction The behavioural measures in the STEPS Instrument relate to risky behaviour 

with regards to chronic diseases.  In particular, they are designed to record 

details about: 

 

• tobacco use 

• alcohol consumption 

• fruit and vegetable consumption 

• use of oil and fat 

• physical activity 

• history of raised blood pressure and diabetes. 

 

For the rationale for capturing information on these topics, see Part 1,  

Section 1. 

 
Core questions The STEPS Instrument includes core questions for each of the following: 

 

• tobacco use 

• alcohol consumption 

• fruit and vegetable consumption 

• physical activity 

• history of raised blood pressure and diabetes. 

 

The core questions of each are explained in detail in this section below. 

 
Expanded 

questions 
The behavioural measurements section of the STEPS Instrument includes 

expanded questions for each of the following: 

 

• tobacco use 

• alcohol consumption 

• use of oil and fat 

• sedentary behavior 

• history of raised blood pressure and diabetes. 

 

The expanded questions of each are explained in detail in this section below. 

Continued on next page 
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Behavioural Measurements (Step 1), Continued 

 

Core questions 

on tobacco use 
The tobacco-related questions recommended for the STEPS approach are 

based on the WHO guidelines for tobacco use surveillance (95).  
 

Even though in some countries it is only men who smoke, women as well as 

men must be asked these questions. 
 

The questions in the STEPS Instrument ask about: 
 

• current smoking 

• daily smoking 

• age when starting smoking 

• number of items smoked per day. 
 

The following skip instructions apply: 
 

• T1: If a person does not currently smoke, go to the questions on past daily 

smoking (T6); 

• T2: If a person does not smoke daily, go to the questions on past daily 

smoking (T6); 

• T3: If a daily smoker tells you the age when he/she started smoking, T4a-c 

("how long ago was this?") can be skipped; 

• T5a-T5other: Once a daily smoker has answered how many items he/she 

smokes each day, you can continue with T9 (use of smokeless tobacco) and 

skip the questions on past smoking (T6-T8a-c). 

 

Expanded 

questions on 

tobacco use 

The expanded tobacco questions focus on past smoking, the use of smokeless 

tobacco and on exposure to smoke and include questions on 
 

• past smoking and age stopped smoking 

• current use of smokeless tobacco 

• daily use of smokeless tobacco 

• number of times smokeless tobacco is used per day  

• past use of smokeless tobacco 

• passive smoking. 
 

The following skip instructions apply: 
 

• T6: If a person has never smoked daily, go to the questions on use of 

smokeless tobacco; 

• T7: If a past daily smoker tells you the age when he/she stopped smoking, 

T8a-c ("how long ago was this?") can be skipped; 

• T9: If a person does not use smokeless tobacco, go to T12 (past use of 

smokeless tobacco); 

• T10: If a person does not use smokeless tobacco daily, go to T12 (past use 

of smokeless tobacco); 

• T11a-T11other: Once a daily user of smokeless tobacco has answered how 

many items he/she uses each day, you can continue with T13 (exposure to 

smoke) and skip the question on past use of smokeless tobacco (T12). 

Continued on next page 



Part 3: Training and Practical Guides  3-2-17 

Section 2: Interviewer's Guide  WHO STEPS Surveillance 

Last Updated: 12 December 2008 

Behavioural Measurements (Step 1), Continued 

 
Expanded 

questions on 

tobacco use 

(cont.) 

In some settings, smokeless tobacco will be more prevalent than smoking 

tobacco.  For these settings, it is strongly recommended to include the 

expanded questions on tobacco use. 

 
Tobacco use 

show card 
See Part 5, Section 3 for a list of tobacco products as well as tobacco show 

cards.  It is recommended that countries develop their own show cards 

displaying country specific examples of tobacco products. 

 
Core questions 

on alcohol 

consumption 

The consumption of alcohol varies a lot within and across countries, and 

different patterns of alcohol consumption are associated with different levels 

of risk.  Alcohol consumption can be episodic, and asking individuals about 

their average (daily) consumption can be problematic.  In addition, while 

some communities abstain from alcohol entirely or may use alcohol on very 

rare and specific occasions, others usually consume it rather regularly.  Even 

though in some countries, only men may consume alcohol, women as well as 

men must be asked these alcohol related questions. 

 

Due to the above mentioned reasons, surveys of alcohol consumption should 

attempt to capture amount and frequency as well as patterns of drinking. 

 

The questions in the STEPS Instrument ask about: 

 

• lifetime consumption of alcohol; 

• past 12 month consumption of alcohol and it's frequency; 

• general consumption of alcohol in past 30 days; 

• number of occasions of alcohol consumption in the past 30 days; 

• average number of drinks per drinking occasion; 

• largest number of drinks per drinking occasion; 

• number of occasions with five or more (for men)/four or more (for women) 

drinks in one occasion. 
 

The following skip instructions apply: 

 

• A1a: If a person has never drunk, you don't have to ask the rest of the 

alcohol questions; 

• A1b: If a person has not drunk within the past 12 months, you can skip to 

D1 (questions on fruit and vegetable consumption); 

• A3: If a person has not drunk within the past 30 days, you can skip to D1 

(questions on fruit and vegetable consumption). 

Continued on next page 
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Behavioural Measurements (Step 1), Continued 

 
Expanded  

questions on 

alcohol 

consumption 

The expanded alcohol questions focus on drinking with meals and on 

drinking in the past 7 days.  They will only need to be answered by those who 

replied "yes " to A3. 

 
Alcohol 

consumption 

show card 

The definition of a "standard drink" will have to be reviewed and potentially 

modified by each site on the show cards, included in Part 5, Section 3, to 

reflect local types of alcohol.  This will include: 

 

• types and strengths of products  

• common measures  

• local terms used for both. 

 

If domestic manufacture of beer, wine or spirits is common, information on 

the usual ethanol content of such products should also be available to help 

determine the volume of absolute alcohol that makes a "standard drink". 

 
Core questions 

on diet 
The STEPS questions on diet include: 

 

• the number of days fruit is eaten in a typical week 

• the number of servings on one of these days 

• the number of days vegetables are eaten in a typical week 

• the number of servings on one of those days. 

 

The following skip instructions apply: 

 

• D1: If a person reports 0 days of fruit consumption, go to D3 (vegetables 

consumption); 

• D3: If a person reports 0 days of vegetables consumption, go to D5, if 

applicable, or to the physical activity questions. 

 
Expanded 

questions on 

diet 

The expanded diet questions ask about the type oil or fat most often used for 

cooking, and about the number of meals consumed outside a home. 

 
Diet show card The diet show card in Part 5, Section 3 will have to be updated to show 

examples of fruits and vegetables considered most typical for your site.  For 

comparative purposes, serving size is standardized to represent 80 grams. 

Continued on next page 
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Behavioural Measurements (Step 1), Continued 

 

Core questions 

on physical 

activity 

The STEPS physical activity questions represent the Global Physical Activity 

Questionnaire, version 2 (GPAQ).  This questionnaire assesses physical 

activity behaviour in three different domains: at work (which includes paid 

and unpaid work, in and outside of the home), for transport (to get to and 

from places), and during leisure time.  
 

Some people will be physically active in all three domains, others may not be 

active in any of the settings.  In any case, questions from all three domains 

should be asked. 
 

The GPAQ questions include: 
 

• involvement in vigorous activities at work; 

• number of days in a typical week with vigorous physical activity at work, 

and  time spent in this activity on one of those days; 

• involvement in moderate activities at work; 

• number of days in a typical week with moderate physical activity at work, 

and  time spent in this activity on one of those days; 

• involvement in physical activity for transport; 

• number of days in a typical week with activity for transport, and time spent 

in this activity on one of those days; 

• involvement in vigorous activities during leisure time; 

• number of days in a typical week with vigorous physical activity during 

leisure time, and  time spent in this activity on one of those days; 

• involvement in moderate activities during leisure time; 

• number of days in a typical week with moderate physical activity during 

leisure time, and  time spent in this activity on one of those days. 
 

The following skip instructions apply: 
 

• P1: If a person has not been involved in vigorous physical activities at work, 

go to moderate physical activities at work (P4); 

• P4: If a person has not been involved in moderate physical activities at 

work, go to physical activities for transport (P7); 

• P7: If a person has not been involved in physical activities for transport, go 

to vigorous physical activities during leisure time (P10); 

• P10: If a person has not been involved in vigorous physical activities during 

leisure time, go to moderate physical activities during leisure time (P13); 

• P13: If a person has not been involved in moderate physical activities 

during leisure time, go to sedentary behaviour (P16). 

 

Expanded 

question on 

physical 

activity 

The expanded question on physical activity assesses the time spent sitting on 

a typical day. 

Continued on next page 
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Behavioural Measurements (Step 1), Continued 

 
Physical 

activity show 

card 

The physical activity show cards will have been adapted by each site to show 

types of physical activities. 

See Part 5, Section 3 for a list of typical physical activities as well as a few 

examples on show cards that have been developed by countries and that display 

country specific examples of physical activities. 

 
Core 

questions on 

history of 

raised blood 

pressure 

The core questions on history of raised blood pressure include whether a 

person has ever had his/her blood pressure measured, whether he/she has been 

told that he/she has raised blood pressure, as well as whether this was in the 

past 12 months.  

 

The following skip instructions apply: 

 

• H1: If a person's blood pressure has never been measured, the rest of the 

history of blood pressure questions can be skipped; 

• H2a: If a person has never been told that he/she has raised blood pressure, the 

rest of the history of blood pressure questions can be skipped. 

 
Expanded 

questions on 

history of 

raised blood 

pressure 

The expanded STEPS questions on history of raised blood pressure include: 

 

• treatment of raised blood pressure 

• traditional treatment of raised blood pressure. 

 
Core 

questions on 

history of 

diabetes 

The core questions on history of diabetes include whether a person has ever 

had his/her blood sugar measured, whether he/she has been told that he/she has 

raised blood sugar, as well as whether this was in the past 12 months.  

 

The following skip instructions apply: 

 

• H6: If a person's blood sugar has never been measured, the rest of the history 

of blood sugar questions can be skipped; 

• H7a: If a person has never been told that he/she has raised blood sugar, the 

rest of the history of blood sugar questions can be skipped. 

 
Expanded 

questions on 

history of 

diabetes 

The expanded STEPS questions on history of raised blood sugar include: 

 

• treatment of raised blood sugar 

• traditional treatment of raised blood sugar. 
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Section 3: Guide to Physical Measurements (Step 2) 

Overview 

 
Introduction This section provides information on and is a guide to working with the topics 

covered under Step 2 of the STEPS Instrument. 

 
Intended 

audience 
This section is designed for use by those fulfilling the following roles: 

 

• interviewers 

• data collection team supervisor 

• STEPS Site Coordinator. 

 
In this section This section covers the following topics: 

 

Topic See Page 

Physical Measurements Overview 3-3-2 

Physical Measurements 3-3-3 

Taking Blood Pressure and Recording Heart Rate 3-3-5 

Measuring Height 3-3-8 

Measuring Weight 3-3-9 

Measuring Waist Circumference 3-3-11 

Measuring Hip Circumference 3-3-13 
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Physical Measurements Overview 

 
Introduction Step 2 of the STEPS Instrument includes selected physical measures to 

determine the proportion of adults that: 

 

• have raised blood pressure  

• are overweight and/or obese. 

 
What you will 

learn 
In this section, you will learn: 

 

• what the physical measures are and what they mean 

• what equipment you will need 

• how to assemble and use the equipment 

• how to take physical measurements and accurately record the results. 

 
Learning 

outcomes 

objectives 

The learning outcome of this section is to understand what the physical 

measures are and how to accurately take the measurements and record the 

results. 
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Physical Measurements 

 

Introduction Blood pressure is taken from the participants to determine the proportion of 

the population with raised blood pressure. Height and weight measurements 

are taken to calculate body mass index (BMI) that is used to determine the 

prevalence of overweight and obesity in the population.  

 

Units of 

measurement 
The table below shows the standard units of measurement for physical 

measurements used in STEPS and their upper and lower limits for data entry 

purposes. 
 

Physical Measure Unit Minimum Maximum 

Systolic blood pressure (SBP) mmHg 40 300 

Diastolic blood pressure (DBP)  mmHg 30 200 

Height cm 100 270 

Weight Kg 20 350 

BMI (body mass index) Kg/m
2
 11 75 

Waist circumference cm 30 200 

Hip circumference cm 45 300 

Heart rate beats/minute 30 200 

 

Sequence of 

tests 
In most sites, the physical measurements (Step 2) are done immediately after 

the behavioural measurements (Step 1).  Since the participant must have 

rested for 15 minutes before the blood pressure measurement, it is most 

convenient to start the Step 2 measurements with blood pressure as the 

participant will have already been sitting for the duration of the interview.  

The Step 2 measurements should hence be taken from the participant in the 

following order: 
 

1. Blood pressure (and heart rate, if measured) 

2. Height 

3. Weight 

4. Waist circumference 

5. Hip circumference (if measured). 

 

Equipment 

required for 

tests 

The equipment you will need for taking physical measurements include: 

 

• blood pressure monitor and appropriate cuff sizes;  

• height measuring board; 

• weighing scales; 

• wooden board (in case of uneven surfaces for scales); 

• tape measure; 

• pen; 

• chair or coat rack for participant's clothes; 

• curtain or screen to provide privacy if no private area is available for taking 

measurements. 

Continued on next page 
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Physical Measurements, Continued 

 
Privacy Where possible, all physical measurements should be conducted in a private 

area. In some settings, a separate room in the household may be set up with 

the necessary equipment to take each measurement.  Where this is not 

possible, a separate area should be screened off to provide privacy for waist 

and hip circumference measurements at minimum. 

 

Allow the participant to select the degree of privacy – some may be 

concerned about going behind a screen or out of sight of others with people 

they do not know. 

 
When to take 

physical 

measurements 

and record 

results 

It is recommended that physical measurements are taken immediately after 

the Step 1 interviews.  Results of Step 2 measures are to be recorded on the 

same participant instruments. 

 

If physical measurements are taken some time after Step 1 interviews (not 

recommended), care should be taken to ensure data collection forms are 

correctly matched with their original instruments. 

 
Introductions 

and 

explanations 

Prior to taking physical measurements, explain that you will be taking the 

following measurements: 

 

For Core 

• blood pressure 

• height 

• weight 

• waist circumference 

 

For Expanded 

• heart rate 

• hip circumference. 
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Taking Blood Pressure and Recording Heart Rate 

 

Introduction Blood pressure is taken to determine the prevalence of raised blood pressure 

in the population. 

 

Equipment To take blood pressure you will need the following: 
 

• digital automatic blood pressure monitor, e.g. OMRON 

• appropriate size cuffs. 

 

Preparing the 

participant 
Ask the participant to sit quietly and rest for 15 minutes with his/her legs 

uncrossed.  If physical measurements (Step 2) are done immediately after the 

behavioural measurements (Step 1), as recommended, the participant should 

have already been seated for at least 15 minutes, and the blood pressure 

measurements can be done immediately after finishing the Step 1 questions. 

 

Three 

measurements 
Three blood pressure measurements should be taken.  During data analysis 

the mean of the second and third readings will be calculated.  The participant 

will rest for three minutes between each of the readings. 

 

Recording the 

blood pressure 

measurements 

 

For recording the results of the blood pressure measurements, do the 

following: 
 

• record your Interviewer ID (if not already filled in) in the participant's 

instrument; 

• after each of the three measurements, record the results in the participant's 

instrument; 

• check that all readings are correctly filled in the instrument; 

• inform the participant on the blood pressure readings only after the whole 

process is completed. 

 

Recording 

heart rate 

measurements 

If a country/site decides to include the expanded measurement of heart rate, 

the recording should be done along with the recording of the blood pressure 

measurements after each of the three measurements.  Heart rate and blood 

pressure results are displayed simultaneously. 

 

OMRON 

procedure 
The instructions below apply to the use of an OMRON blood pressure 

monitor. However, more detailed operating instructions are included with the 

device and should be reviewed before taking any blood pressure 

measurements. 
 

Note that in case you use a different digital automatic blood pressure monitor, 

you should also read the instructions for the according machine carefully. 

Continued on next page 
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Taking Blood Pressure and Recording Heart Rate, Continued 

 
Applying the 

OMRON cuff 
Follow the steps below to select an appropriate size and apply the cuff: 

 

Step Action 

1 Place the left arm* of the participant on the table with the palm 

facing upward. 

2 Remove or roll up clothing on the arm. 

3 Select the appropriate cuff size for the participant using the 

following table: 
 

Arm Circumference (cm) Cuff Size 

17 -22 Small (S) 

22-32 Medium (M) 

> 32 Large (L) 
  

4 Position the cuff above the elbow aligning the mark ART on the 

cuff with the brachial artery. 

5 Wrap the cuff snugly onto the arm and securely fasten with the 

Velcro.   
 

Note:  The lower edge of the cuff should be placed 1.2 to 2.5 cm 

above the inner side of the elbow joint. 

6 Keep the level of the cuff at the same level as the heart during 

measurement. 
 

*Note: If the right arm is used, note this in the right hand side margin on the 

participant's Instrument. 

 
Taking the 

measurement 

with an 

OMRON 

Follow the instructions below to take the blood pressure measurement:  

Step Action 

1 Switch the monitor on (dark purple button) and press START 

(light purple button). 

2 The monitor will start measuring when it detects the pulse and the 

"heart" symbol will begin to flash.  The systolic and diastolic blood 

pressure readings should be displayed within a few moments 

(systolic above and diastolic below). 

3 Record the reading in the participant's instrument. 

4 Switch the monitor off, but leave the cuff in place. 

5 Wait three minutes, then repeat steps 1-4 two more times. 

Continued on next page 
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Taking Blood Pressure and Recording Heart Rate, Continued 

 
When to use a 

Sphygmomano-

meter 

The sphygmomanometer is generally not recommended, but may be used in 

the following circumstances: 

 

• the OMRON is not functioning; 

• the OMRON display shows multiple errors; 

• to cross check OMRON blood pressure readings in various clinical states 

such as irregular pulse, peripheral circulatory disturbance, extreme 

hypotension; 

• for calibration of the OMRON Monitor. 

 
Procedure for 

Sphygmomano

meter 

Follow the steps below or refer to the operating instructions included with the 

device to measure the blood pressure of a participant using the 

sphygmomanometer. 

 

Step Action 

1 Apply the cuff (as detailed above). 

2 Put stethoscope earpieces in ear and set to bell. 

3 Palpate pulse at either brachial or radial artery.  Take a pulse count 

for one full minute. 

4 Pump up pressure and inflate cuff until unable to feel pulse. 

5 Continue to inflate cuff 30 mmHg beyond this point. 

6 Apply the bell of the stethoscope to the right antecubital fossa. 

7 Listen for pulse sounds while deflating the cuff slowly. 

8 Record the systolic blood pressure (SBP) when a pulse is first 

audible. 

9 Record the diastolic blood pressure (DBP) when the pulse sound 

disappears. 

10 Deflate the cuff fully and let the arm rest for three minutes 

(between each of the readings). 

11 Repeat Steps 2-10 twice to obtain three readings. 

12 Check that all readings are correctly filled in on the instrument. 

13 Record your Technician ID code on the participant’s instrument. 

14 Inform the participant the blood pressure readings only after the 

whole process is completed. 
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Measuring Height 

 

Introduction The height of eligible participants is taken to help calculate their body mass 

index (BMI), which is their weight relative to their height, and therefore to 

determine the prevalence of overweight and obese people in the population. 

 

Equipment To measure height, you need a portable height/length measuring board. 

 

Assembling the 

measuring 

board 

Follow the steps below to assemble the measuring board: 

 

Step Action 

1 Separate the pieces of board (usually 3 pieces) by unscrewing the 

knot at the back. 

2 Assemble the pieces by attaching each one on top of the other in 

the correct order. 

3 Lock the latches in the back.  

4 Position the board on a firm surface against a wall.  

 

Procedures Follow the steps below to measure the height of a participant: 
 

Step Action 

1 Ask the participant to remove their: 
 

• footwear (shoes, slippers, sandals, etc) 

• head gear (hat, cap, hair bows, comb, ribbons, etc). 
 

Note:  If it would be insensitive to seek removal of a scarf or veil, 

the measurement may be taken over light fabric. 

2 Ask the participant to stand on the board facing you.   

3 Ask the participant to stand with: 
 

• feet together  

• heels against the back board 

• knees straight. 

4 Ask the participant to look straight ahead and not tilt their head up. 

5 Make sure eyes are the same level as the ears. 

6 Move the measure arm gently down onto the head of the 

participant and ask the participant to breathe in and stand tall. 

7 Read the height in centimetres at the exact point. 

8 Ask the participant to step away from the measuring board. 

9 Record the height measurement in centimetres in the participant’s 

Instrument. 

10 Record your Technician ID code in the space provided in the 

participant’s instrument. 
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Measuring Weight 

 

Introduction The weight of eligible participants is taken to help determine their body mass 

index (BMI), which is their weight relative to their height, and therefore to 

determine the prevalence of overweight and obese people in the population. 

 

Equipment To measure weight, you will need the following equipment: 

 

• portable electronic weighing scale; 

• a stiff wooden board to place under the scales, if you are likely to have 

problems with uneven surfaces (such as dirt or mud floors or carpet); 

• a generator, if electronic scales are being used and electricity is not 

guaranteed in all survey areas (check if scale can work with batteries). 

 

Set up 

requirements 
Make sure the scales are placed on a firm, flat surface. 
 

Do not place the scales on: 
 

• carpet 

• a sloping surface 

• a rough, uneven surface. 

 

Electronic 

scales 
Follow the steps below to put electronic scales into operation: 

 

Step Action 

1 Put the scale on a firm, flat surface. 

2 Connect the adaptor to the main power line or generator. 

3 Turn on the scale. 

4 Switch the scale on and wait until the display shows 0.0. 

 

Procedures Follow the steps below to measure the weight of a participant: 

 

Step Action 

1 Ask the participant to remove their footwear (shoes, slippers, 

sandals, etc) and socks. 

2 Ask the participant to step onto scale with one foot on each side of 

the scale. 

3 Ask the participant to: 

• stand still 

• face forward  

• place arms on the side and  

• wait until asked to step off. 

Continued on next page 
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Measuring Weight, Continued 

 
Procedures (cont.) 

 

Step Action 

4 Record the weight in kilograms on the participant’s instrument. 

 

If the participant wants to know his/her weight in pounds, convert 

by multiplying the measured weight by 2.2. 
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Measuring Waist Circumference 

 
Introduction Waist circumference measurements are also taken to provide additional 

information on overweight and obesity. 

 
Equipment To take waist circumference measurements you will need a: 

 

• constant tension tape (for example, Figure Finder Tape Measure) 

• pen 

• chair or coat stand for participants to place their clothes. 

 
Privacy A private area is necessary for this measurement.  This could be a separate 

room, or an area that has been screened off from other people within the 

household. 

 
Preparing the 

participant 
This measurement should be taken without clothing, that is, directly over the 

skin.  

 

If this is not possible, the measurement may be taken over light clothing.  It 

must not be taken over thick or bulky clothing.  This type of clothing must be 

removed. 

 
How to take the 

measurement 
This measurement should be taken: 

 

• at the end of a normal expiration; 

• with the arms relaxed at the sides; 

• at the midpoint between the lower margin of the last palpable rib and the top 

of the iliac crest (hip bone).  

Continued on next page 
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Measuring Waist Circumference, Continued 

 
Procedure Follow the steps below to measure the waist circumference of a participant: 

 

Step Action 

1 Standing to the side of the participant, locate the last palpable rib  

and the top of the hip bone.  You may ask the participant to assist 

you in locating these points on their body. 

2 Ask the participant to wrap the tension tape around themselves and 

then position the tape at the midpoint of the last palpable rib and 

the top of the hip bone, making sure to wrap the tape over the same 

spot on the opposite side.  

 

Note: Check that the tape is horizontal across the back and front of 

the participant and as parallel with the floor as possible. 

3 Ask the participant to: 

 

• stand with their feet together with weight evenly distributed 

across both feet; 

• hold the arms in a relaxed position at the sides; 

• breathe normally for a few breaths, then make a normal 

expiration. 

4 Measure waist circumference and read the measurement at the 

level of the tape to the nearest 0.1 cm, making sure to keep the 

measuring tape snug but not tight enough to cause compression of 

the skin. 

5 Record the measurement on the participant’s Instrument.   

 

Note: Measure only once and record. 
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Measuring Hip Circumference 

 
Introduction Hip circumference measurements are taken in some sites as an expanded 

option to measure overweight and obesity. 

 
Equipment To take hip circumference measurements you will need a: 

 

• constant tension tape (for example, Figure Finder Tape Measure) 

• pen 

• chair or coat stand for participant's to place their clothes. 

 
Privacy A private area is necessary for this measurement.  This could be a separate 

room, or an area that has been screened off from other people within the 

household.  Hip measurements are taken immediately after waist 

circumferences. 

 
Preparing the 

participant 
This measurement should be taken without clothing, that is, directly over the 

skin.  

 

If this is not possible, the measurement may be taken over light clothing.  It 

must not be taken over thick or bulky clothing.  This type of clothing must be 

removed. 

 
How to take the 

measurement 
This measurement should be taken: 

 

• with the arms relaxed at the sides 

• at the maximum circumference over the buttocks. 

Continued on next page 
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Measuring Hip Circumference, Continued 

 
Procedure Follow the steps below to take hip circumference measurements. 

 

Step Action 

1 Stand to the side of the participant, and ask them to help wrap the 

tape around themselves.  

2 Position the measuring tape around the maximum circumference of 

the buttocks. 

3 Ask the participant to: 

 

• stand with their feet together with weight evenly distributed over 

both feet;  

• hold their arms relaxed at the sides. 

4 Check that the tape position is horizontal all around the body and 

snug without constricting. 

5 Measure hip circumference and read the measurement at the level 

of the tape to the nearest 0.1 cm. 

6 Record the measurement on the participant’s instrument.   

 

Note:  Measure only once and record. 
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Section 4: Guide to Biochemical Measurements (Step 3) 

Overview 

 
Introduction This section provides information on taking biochemical measures required 

under Step 3 of the STEPS Instrument. 

 
Intended 
audience 

This section is designed for use by those fulfilling the following roles: 
 
• data collection team supervisor 
• health professionals (for clinic setting) 
• STEPS Site Coordinator. 

 
In this section This section covers the following topics: 
 

Topic See Page 
Biochemical Measurements Overview 3-4-2
Blood Collection 3-4-3
Blood Glucose Measurement 3-4-5
Cholesterol Measurement 3-4-6
Triglyceride Measurement 3-4-7
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Biochemical Measurements Overview 

 
Introduction Step 3 includes selected biochemical measurements that require taking blood 

samples. 
 
Step 3 is usually conducted in a clinic setting.  It is only conducted in 
countries where resources permit as Step 3 approximately doubles the overall 
cost of the survey.  

 
What you will 
learn 

In this module, you will learn: 
 
• what the biochemical measures are and what they mean 
• the fasting process and instructions for participants 
• what equipment you will need 
• how to take biochemical measurements 
• how to record the results. 

 
Learning 
outcome 

The learning outcome of this section is to understand what the biochemical 
measures are and how to accurately prepare participants, take the 
measurements and record results. 

 
Recording 
results 

The same participant instruments that have been used for Step 1 and Step 2 
should be used to record the Step 3 results.  However, the page for collecting 
results from Step 3 may be separated so that Step 1 and Step 2 results can be 
sent to the data entry office once those Steps have been completed.  The 
participant ID should already be filled in on the Step 3 results page of the 
instrument (see Part 2, Section 2 "Preparing Data Collection Forms"). 

 
Required forms Where Step 3 is conducted in a clinic the following forms are also to be used: 

 
• Clinic Registration Form 
• Participant Feedback Form Step 3. 

 
Note: These forms can be found in Part 6, Section 2. 

 
Dry vs. wet 
chemistry 

There are two main blood chemistry screening methods: dry and wet 
chemistry.  Dry chemistry means that blood is taken from the fingertip, while 
wet chemistry means that a venous blood sample is drawn.  See Part 2, Section 
1 for further information on dry and wet chemistry.   
 
Note: In this section, only the dry chemistry method is described since wet 
chemistry is done directly at the laboratory. 
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Blood Collection 

 
Introduction Blood samples are taken from eligible participants to be used to perform 

simple tests to measure blood glucose and blood lipids. 

 
Infection 
control 

Follow the infection control procedures appropriate for your facility. 
 
Whole blood is more infective with regard to blood borne disease than 
centrifuged serum or plasma.  There may be an increased risk in handling 
whole blood and universal precautions should be adopted. 

 
Units of 
measurement 

The table below shows the standard units of measurement for biochemical 
tests used in STEPS and their upper and lower limits for data entry purposes. 

 
Blood Test Unit Minimum Maximum 

Fasting glucose mmol/L 1 35.0 
Random glucose mmol/L 1 50.0 
Total cholesterol mmol/L 1.75 20.0 
HDL mmol/L 0.10 5.0 
Fasting triglycerides mmol/L 0.25 50.0 
Total cholesterol/HDL ratio mmol/L 1.10 30.0 

 
Participant 
fasting 
requirements 

To obtain accurate results, participants must fast for at least 12 hours before 
blood collection.  This is particularly important for the measurements of 
blood glucose as well as triglycerides, if applicable. 
 
Most blood samples are to be taken in the morning.  This means participants 
must not to eat or drink anything (except plain water) from about 8 pm the 
night before. 
 
Diabetic patients on medication are required to bring their tablets with them 
and to take them after their blood measurement if possible (if they have not 
done so, they should inform the relevant laboratory staff). 

 
Note:  Fasting Instructions for Step 3 can be found in Part 6, Section 2. 

Continued on next page 
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Blood Collection, Continued 

 
Preparing the 
participant 

After greeting the participant, and asking them to take a seat, follow the steps 
below to prepare the participant for a blood test: 

 

Step Action 
1 Fill in the following details on the Clinic Registration Form: 

 

• Date 
• Participant ID (if not already filled in) 
• Participant Name (if not already filled in) 
• check Consent Form if Consent Form 2 has been signed. 

2 Ask the fasting question (first question on the instrument under 
Step 3, Code B1) and circle the answer. 

3 If the participant has not fasted correctly, then: 
• note "fasting default" on the participant’s instrument; 
• explain that to get accurate results participants need to fast for a 

minimum of 12 hours; 
• ask if they would try fasting again and come back for a blood test 

the following day. 
 
If the participant agrees to come back the following day, then:  
• give the participant an appointment time and fasting instructions; 
• note the time of the new appointment in the Clinic Registration 

Form; 
• inform the supervisor. 

4  
If... Then explain to the participant that… 

The participant has 
fasted correctly 

• blood is going to be collected from a 
small prick on the finger; 

• tests will be done on: fasting blood 
sugar, cholesterol and fasting 
triglycerides.   
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Blood Glucose Measurement 

 

Introduction Blood sugar tests are taken to measure for raised blood sugar levels which are 
a risk factor for diabetes.  

 

Equipment 
required 

Dry chemistry equipment and supplies required for blood glucose tests 
include: 
 

• blood glucose measuring device (such as: Reflotron Plus, Accutrend Plus or 
HemoCue 201 DM); 

• test strips; 
• lancet; 
• cotton balls; 
• sterile swabs; 
• gloves; 
• disposable container. 

 

Preparing the 
device 

Follow the appropriate device instructions to set up, prepare and use the meter 
for blood glucose tests. 

 

Blood glucose 
measurement 
procedure 

Follow the steps below to take blood glucose measurements and record the 
results.  Note that you should also read the instructions provided with the 
device carefully. 

 

Step Action 
1 Put on gloves. 
2 Remove a test strip. 
3 Rub and kneed a fingertip to help withdraw blood (rub the side of the 

participant's finger closest to the thumb). 
4 Wipe or swab the fingertip by using a sterile swab. 
5 Lance the massaged place on the fingertip with lancing device. 
6 Allow a hanging blood drop to form without applying too much pressure. 
7 Carefully apply the drop of blood to the test field on top of the strip 

without touching the test field directly to the finger. 
 

Note:  The test field must be completely covered with blood. If too little 
blood is applied, do not rub it in or apply a second drop, but repeat the 
measurement with a fresh test strip. 

8 Give the participant a cotton ball to press on the puncture. 
9 Put the test strip into the machine. 
10 Wait for the measurement to be displayed (after a series of beeps followed 

by longer beep). The blood glucose results is usually displayed in 
mmol/L.  

11 Record the results of the fasting blood sugar reading in the participant’s 
instrument and in the Participant Feedback Form (Step 3).  Also tick the 
corresponding box on this form. 

12 Record Technician ID, Device ID, time of day and answer to medication 
question (B6) in the participant's instrument. 
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Cholesterol Measurement 

 

Introduction Blood cholesterol tests are taken to measure total cholesterol and HDL 
cholesterol levels. 

 

Equipment 
required 

Dry chemistry equipment and supplies required for cholesterol measurements 
include: 
 

• cholesterol measuring device (such as: Reflotron Plus, Accutrend Plus, or 
Cholestech LDX); 

• test strips; 
• lancet; 
• cotton balls; 
• sterile swabs; 
• gloves; 
• disposable container. 

 

Preparing the 
device 

Follow the appropriate device instructions to set up, prepare and use the meter 
for cholesterol tests. 

 

Cholesterol 
measurement 
procedure 

Follow the steps below to take cholesterol measurements and record the 
results.  Note that you should also read the instructions provided with the 
device carefully. 

 

Step Action 
1 Put on gloves. 
2 Remove a test strip. 
3 Rub and kneed a fingertip to help withdraw blood (rub the side of the 

participant's finger closest to the thumb). 
4 Wipe or swab the fingertip by using a sterile swab. 
5 Lance the massaged place on the fingertip with lancing device. 
6 Allow a hanging blood drop to form without applying too much pressure. 
7 Carefully apply the drop of blood to the test field on top of the strip 

without touching the test field directly to the finger. 
 

Note:  The test field must be completely covered with blood. If too little 
blood is applied, do not rub it in or apply a second drop, but repeat the 
measurement with a fresh test strip. 

8 Give the participant a cotton ball to press on the puncture. 
9 Put the test strip into the machine. 
10 Wait for the measurement to be displayed (after a series of beeps followed 

by longer beep). The blood cholesterol results are usually displayed in 
mmol/L.  

11 Record the results of the blood cholesterol reading in the participant’s 
instrument and in the Participant Feedback Form (Step 3).  Also tick the 
corresponding box on this form. 

12 Record Device ID, and answer to medication question (B9) in the 
participant's instrument. 
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Triglyceride Measurement 

 
Introduction Triglyceride tests are taken to measure the fasting levels of natural fats and 

oils in the bloodstream. 

 
Equipment 
required 

Dry chemistry equipment and supplies required for triglyceride measurements 
includes: 
 
• triglyceride measuring device (such as: Reflotron Plus, Accutrend Plus, or 

Cholestech LDX); 
• test strips; 
• lancet; 
• cotton balls; 
• sterile swabs; 
• gloves; 
• disposable container. 

 
Preparing the 
device 

Follow the appropriate device instructions to set up, prepare and use the meter 
for triglyceride tests. 

 
Triglyceride 
measurement 
procedure 

Follow the steps below to take triglyceride measurements and record the 
results.  Note that you should also read the instructions provided with the 
device carefully. 

 

Step Action 
1 Put on gloves. 
2 Remove a test strip. 
3 Rub and kneed a fingertip to help withdraw blood (rub the side of the 

participant's finger closest to the thumb). 
4 Wipe or swab the fingertip by using a sterile swab. 
5 Lance the massaged place on the fingertip with lancing device. 
6 Allow a hanging blood drop to form without applying too much pressure. 
7 Carefully apply the drop of blood to the test field on top of the strip 

without touching the test field directly to the finger. 
 
Note:  The test field must be completely covered with blood. If too little 
blood is applied, do not rub it in or apply a second drop, but repeat the 
measurement with a fresh test strip. 

8 Give the participant a cotton ball to press on the puncture. 
9 Put the test strip into the machine. 
10 Wait for the measurement to be displayed (after a series of beeps followed 

by longer beep). The triglyceride results are usually displayed in mmol/L. 
11 Record the results of the triglyceride reading in the participant’s 

instrument and in the Participant Feedback Form (Step 3).  Also tick the 
corresponding box on this form. 
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Section 5: Data Entry Guide 

Overview 

 
Introduction This section provides general guidelines and training for data entry staff. A 

suggested schedule for training data entry staff is located in Part 3, Section 1.  
Instructions for supervising data entry and creating the final data set are 
covered in Part 4, Section 2. 

 
Intended 
audience 

This section is designed for use by those fulfilling the following roles: 
 
• data entry supervisor 
• data entry staff 
• STEPS Site Coordinator. 

 
In this section This section covers the following topics: 
 

Topic See Page 
Using the Computer 3-5-3
Data Entry Process 3-5-5
Data Entry Rules and Guidelines 3-5-7
Introduction to EpiData 3-5-9 
Using EpiData for Data Entry 3-5-10 
Consistency Reports 3-5-15 
Backing up Data 3-5-16 
Pilot Test 3-5-17 
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Overview 

 
Introduction Data entry staff play a key role in ensuring that data collected and recorded on 

the completed instruments is accurately entered into the survey database and 
all instruments and associated tracking forms are systematically sorted and 
filed. 

 
Note: Please tailor this training guide according to the baseline level of 
knowledge of your data entry staff. 

 
What you will 
learn 

During this training, you will learn about: 
 
• using the computer 
• the data entry process 
• how to enter data and manage instruments 
• rules and guidelines for data entry 
• using EpiData software and the generic templates 
• how to handle problematic (e.g. incorrectly completed) instruments 
• how to produce a consistency report on entered data 
• how to back up entered data. 

 
Learning 
outcomes  

The learning outcome of this course is accurate, efficient and well-
documented entry of STEPS survey data from the instruments and Interview 
Tracking Forms. 

 
Other data 
entry materials 

This guide is to be used in conjunction with the following Sections in the 
STEPS Surveillance Manual.  These sections provide full instructional 
material on the following topics. 

 
Topic Location 

Preparing the Data Entry Environment Part 2, Section 4 
Data Entry Part 4, Section 2 
STEPS Instrument Part 5, Section 1 
Interview and Data Entry Forms Part 6, Section 2 
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Using the Computer 

 
Introduction To use the computer for data entry, and to be able to operate the data entry 

software, you need to know how to: 
 
• work safely 
• turn the computer on 
• open up the software you will be using 
• exit from the software 
• shut down the computer. 

 
Work safely Computers are electrical equipment and must be operated in a safe manner.  

Guidelines for safely operating your personal computer include: 
 

Safety Issue Guideline 
Water and 
dust 

Ensure that at all times the location of your computer is dry 
and clean. Any moisture or build-up of dust can increase 
the chance of electric shocks that can damage you or your 
computer. 

Ergonomics Ensure that your chair and the immediate environment are 
ergonomically placed, that your neck and back especially 
are not twisted or strained while operating the machine. 

Food and 
drinks 

Keep food and drinks away from the computer.  Drinks 
spilled onto the keyboard can damage under the keys. 

Electrical 
storms 

If electrical storms occur while operating the machines, it is 
safest for both you and the machine to switch them off and 
unplug them from the power source, in order to prevent 
electrical surges or spikes damaging the equipment.  

 
Turning on the  
computer 

Follow the steps below to start using your computer: 

 
Step Description 

1 Check that the computer is plugged in to the wall and the environs 
seem safe before turning on the main switch of your computer. 

2 When turned on, you will hear a whirring from the internal fan 
inside the box, and the screen should light up.  Some screens have 
an additional switch which needs to be turned on. 

3 Ensure that the CAPS LOCK light is not lit.  If the light is on, 
press the CAPS LOCK key to turn it off. 

4 If prompted, enter your user ID and password.  The password will 
be assigned to you by your supervisor and must not be shared with 
others. 

5 The screen will show the software that has been set up for you. 

Continued on next page 
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Using the Computer, Continued 

 
Running your 
software 
packages 

The icon for EpiData should be located on your desktop.  Double click on the 
icon to open EpiData. 
 
For tracking the stage, location, and comments from instruments as you enter 
them, you will use the data_entry_tracking.xls Excel file.  The data entry 
supervisor should provide specific directions on how to open Excel on the 
computers. 

 
Creating 
folders 

While the data entry supervisor should have created all necessary folders on 
each machine prior to training, it is still important that data entry staff 
understand how to create a folder on their computers.  Follow the steps below 
to create a folder if you have a mouse that has two buttons: 

 
Step Action 

1 Go to the desktop on your computer. 
2 Locate an empty space on the screen and right click on the mouse. 
3 Select New>Folder from the list. 
4 Type the name of the new folder below the icon for the new folder. 
5 To create a folder within the new folder open the new folder and 

complete steps 2-4. 
 

Note:  If your mouse does not have 2 buttons, you can create a new folder by 
opening Windows Explorer and selecting File>New>Folder from the menu 
options. 

 
Caring for your 
computer 

Occasional care of your computer may be necessary including: 
 
• wiping the keyboard and external surfaces of the box with a soft cloth (not 

damp or wet) when the power is off; 
• cleaning the screen surface with a lint- and static-free cloth; 
• vacuuming external vents to the computer box in dusty environments to 

reduce chances of dust-caused faults. 

 
Closing down 
your computer 

At the end of the day follow the steps below to safely turn off your computer: 
 

Step Action 
1 Close EpiData and Excel. 
2 Use the cursor to go to the lower left corner of the screen. 
3 Select 'Start', then 'Shut down'. 

 
Note:  The machine may do some processing before shutting down.  The 
screen should turn off and then the noises from the internal fan should cease 
as it closes down. 
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Data Entry Process 

 
Introduction Data entry is a systematic process that covers the following main stages: 

 
• receiving and logging 
• data entry 
• validation 
• error correction 
• filing. 

 
Overview of 
process  

The table below gives a very general overview of the data entry process. 

 
Step Description 

1 Completed instruments received, logged, and sorted by content. 
2 Instruments are 1st keyed, using EpiData. 
3 Instruments are 2nd keyed, using EpiData. 
4 Data checked by data entry supervisor and combined into one 

dataset. 

 
Using several 
data entry 
operators 

To complete the survey within the given timeframe it is recommended that a 
team of data entry staff work together.  The team needs to be well supervised 
and managed to ensure: 
 
• each person completes a varied range of tasks each day; 
• good workflow to keep up with completed instruments and forms and keep 

to scheduled timeframes. 

 
Second 
Keying 

It is strongly recommended that all instruments be keyed (entered) twice.  A 
second keying decreases the chance of data entry errors being present in the 
final dataset.  If a team of data entry staff is available, it is recommended to 
have two different staff members perform one keying of each instrument.  With 
multiple staff members, the second keying process would be implemented as 
follows: 

 

Step Description 
1 Staff member 1 is assigned to Computer A and completes the 1st 

keying for all instruments assigned to Computer A. 
2 Staff member 1 and Staff member 2 swap computers.  Staff 

member 2 is now assigned to Computer A. 
3 Staff member 2 completes the 2nd keying for all instruments 

assigned to Computer A. 

Continued on next page 
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Data Entry Process, Continued 

 
Overview of  
handling 
Instruments 

Instruments need to be handled systematically to maintain a good workflow, 
to make sure all problems and queries have been resolved, and to ensure that 
originals can be easily retrieved once completed.  A system should be 
developed that provides explicit directions for how: 
 
• instruments are received and logged by the supervisor; 
• instruments are sorted and assigned to a data entry computer; 
• data entry staff members log receipts of instruments; 
• data entry staff members track the data entry process using the Data Entry 

Tracking Form; 
• instruments are filed as data entry is completed for each instrument; 
• instruments are locked away each night and redistributed each morning. 

 
Handling 
queries 

All queries should be addressed to the data entry supervisor.  When you have 
a query make sure you: 
 
• collect all necessary information about the query prior to contacting your 

supervisor; 
• log any decision about the query on the Data Entry Tracking Form. 
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Data Entry Rules and Guidelines 

 
Introduction To ensure consistently high-quality data and to minimize delays, some 

general rules need to be observed during the data entry process to handle any 
difficulties that may be encountered with a given instrument.  The table below 
provides some general guidelines for the data entry team. 

 
Problem Guideline 

Instrument not 
correctly filled 
out 

The data entry protocols and guidelines will not work if 
the instrument is not filled out correctly by the data 
collection team.  If you come across an instrument that is 
not correctly filled out, immediately consult your 
supervisor.  
 
(For example: The participant replies that he/she does not 
currently smoke but then provides values for how many 
cigarettes they smoke each day.) 

Missing data Some questions may be blank.  Follow the guidelines 
below to handle missing data: 
 

 

If… Then… 
Data is missing in 
a field where data 
is expected. 

Enter 99 or 999 accordingly.  Do 
NOT enter 0. 

Complete date of 
birth or age is not 
provided. 

Enter what is given. If any date is 
available, it will usually be the 
year. 

Year of birth 
(only) is provided 

• Calculate the estimated age of 
participant (survey year - birth 
year) and enter into age. 

• Log calculation in Data Entry 
Tracking Form. 

Surplus data If a decimal value (e.g. 7.5) has been entered where a non-
decimal value is expected, enter the non-decimal part of 
the response (e.g. 7).  For any other problems, consult 
your supervisor. 

Participant ID 
(PID) crossed 
out 

If you come across an instrument where the PID has been 
crossed out and another has been written in pen, then: 
 
• skip the entire instrument and start entering a new one; 
• record both PIDs in the Data Entry Tracking Form and 

note if you entered any data; 
• contact your supervisor. 

Continued on next page 



Part 3: Training and Practical Guides   3-5-8 
Section 5: Data Entry Guide  WHO STEPS Surveillance 
Last Updated: 14 November 2008 

Data Entry Rules and Guidelines, Continued 

 
Topic Guideline 

Value out of 
range 

If an instrument contains a value that is not possible, such 
as 1600 for height instead of 160, the value needs to be 
coded as out of range using 99, 999, or in the special case 
for weight: 666.6.  The data entry tool will not allow an 
implausible value to be entered. 

Other 
problems 

You may come across other situations that are not easy to 
resolve.  If your supervisor is not immediately available 
for consultation, follow the guidelines below: 
 
• do not process the form 
• skip and go on to the next instrument 
• record the PID number and nature of the problem 
• consult the supervisor when he/she becomes available. 

 
Special data 
entry codes 

Special codes have been allocated for use in STEPS to show the reasons data 
are unavailable.  The codes include:  
 
Codes For response 
77 or  777 Don’t know 
88 or 888 Refused 
99 or 999 Missing  
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Introduction to EpiData  

 
Introduction EpiData is a program for entering data.  Although you do not need to be an 

expert in EpiData in order to use this program, it is important that you are 
able to navigate the program. 

 
Opening 
EpiData 

Prior to training, the data entry supervisor should have downloaded and 
installed EpiData on all data entry computers.  Instructions for downloading 
and installing EpiData can be found in Part 2, Section 4. 
 
To open EpiData or any templates associated with EpiData you need to open 
the EpiData program.  To open EpiData either: 
 
• click on the EpiData icon on your desktop, or  
• go to C:\Program Files\EpiData and click on EpiData.exe. 

 
EpiData 
toolbars 

The opening screen of EpiData is blank and contains 6 buttons across the top 
of the screen.  These buttons and their functions are described in the table 
below. 

 
Button Used to… 

1. Define Data Access the .qes file and make changes to the 
look/content of the data entry templates. 

2. Make Data File Create data entry template (.rec file) from the .qes file. 
3. Checks Access the .chk file and define the value ranges and 

skip patterns used during data entry. 
4. Enter Data Enter data.  Use this during pilot testing as well as for 

actual data entry. 
5. Document Print out a codebook to provide all the information 

associated with a template. 
6. Export Data Export data after data entry is complete. 
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Using EpiData for Data Entry 

 
EpiData 
templates 

The STEPS team in Geneva has created generic templates for data entry 
which should be modified by the data entry supervisor to match your site-
specific instrument.  The table below lists the templates. 

 
Template To record 

Survey • Cluster (centre/village) Name 
• Cluster (centre/village) ID 
• Interviewer ID 
• date of completion of the instrument  
• core questions and measures for Step 1, 2 and Step 3, 

as applicable 
• expanded and/or optional questions 

Consent Confidential (personal identification) data 
Biochemical Step 3 measurements, if recorded on a separate form 

 
Note:  Further details on the templates, including instructions for modifying 
them, are provided in Part 2, Section 4. 

 
Location of 
data entry 
templates 

Prior to training, the data entry supervisor is responsible for ensuring that a 
copy of the data entry templates has been placed on all data entry computers 
at the following location: 
 
• C:\STEPS\data 

  

Note: Once training is completed, the data entry templates on all data entry 
computers should be replaced with new copies so that test data is not included 
with the STEPS survey data. 

 
Performing the 
first keying 

The table below provides step-by-step instructions on how to do the 1st keying 
for a completed Instrument. 
 

Step Action 
1 Open the EpiData program and click on the "4. Enter Data" button 

at the top of the screen. 
2 Open the appropriate EpiData template (e.g. survey.rec) from the 

C:/STEPS/data folder. 
3 Take the top instrument from your folder containing instruments 

ready for 1st keying and locate the Participant ID in your 
computer's Data Entry Tracking Form (either in Excel or Word).  

Continued on next page 
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Using EpiData for Data Entry, Continued 

 
Performing the 
first keying 
(cont.) 

Step Action 
4 Beginning with the Participant Identification Number (PID) at 

the top of the STEPS Instrument, enter data into the database 
exactly as it is written.  Use the TAB key to move from one 
question to the next on the data entry screen. 
 
Note: Missing values are not allowed for the following items:  
• PID (Participant Identification Number) 
• I1 (Cluster Number) 
• I4 (Date of completion of Instrument) 
• C1 (Sex) 
• C2 or C3 (Age) 

5 Continue using the TAB key to move from one question to the 
next until you reach the very end of the data entry form.  When 
the last field is reached, EpiData will prompt you to save the 
current record.  Click "Yes" to save the record and get a clean 
data entry form ready for entering data from the next instrument. 

6 Log all discrepancies, questions and problems (irregularities) 
that you cannot resolve into the Data Entry Tracking Form. 
Include: 
 
• code (general identifier for a question, e.g. T1, P5…) 
• brief description of problem 
• supervisor's decision. 

7 When you have completed entering the data from your section 
of the instrument, move the paper copy to the "second key" 
folder and update the Data Entry Tracking Form. 

8 Continue entering the instruments and repeat steps 3-7. 
9 At the end of the day, give the folders to the supervisor to lock 

up. 
 
Note: At the bottom of the EpiData window is an indicator of how many 
records (instruments) have been entered in the current .rec file.  Initially, this 
space will read "New/0" but the text will change as more records are entered.  
It is a good idea to periodically confirm that this number matches the number 
of records that have been entered (e.g. "New/5" indicates that you have 
finished and saved 5 instruments and are currently entering your 6th 
instrument). 

Continued on next page 
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Using EpiData for Data Entry, Continued 

 
Returning to a 
specific record 

Occasionally you may need to return to a specific record in your data file.  
This may be necessary if you had to set aside a problematic instrument to 
await your supervisor's assistance or if you notice that you have skipped a 
section of an instrument you have entered.  Follow the steps below to return 
to a specific record. 
 

 

Step Action 
1 Open the EpiData program and click on the "4. Enter Data" 

button at the top of the screen. 
2 Open the appropriate EpiData template (e.g. survey.rec) from the 

C:/STEPS/data folder. 
3 Select "Find Record" from the Goto menu at the top of the screen.
4 Enter the Participant ID of the instrument of interest in the 

Criteria column next to ID. 
5 Click "OK". 
6 Once all changes/corrections have been made either close 

EpiData or select "New Record" from the Goto menu at the top of 
the screen to continue entering instruments.  Click "Yes" to save 
the modified record when prompted. 

 
Preparing for 
the second 
keying 

A second keying should be done only after a large number of instruments 
have been first keyed on a given computer.  If there is a significant amount of 
time between the arrival of new sets of instruments from the data collection 
team, a second keying can be done on all instruments received while awaiting 
new instruments.  Otherwise, it is best to wait until the first keying has been 
completed on all instruments before proceeding to the second keying. 
 
In order to minimize the potential for error, each instrument should be second 
keyed on the same computer on which it was first keyed.  If multiple data 
entry staff are available, one staff member should use a given computer to 
complete the first keying and another staff member should use the same 
computer to complete the second keying (i.e. staff members should swap 
computers when doing second keying). 
 
The table below provides step-by-step instructions on how to prepare for the 
second keying.  It is important to keep in mind that the file generated from 
this process can only be used for the second keying of those instruments 
entered in the .rec file prior to making this file.  If more instruments are 
received at a later time, these instruments should be first keyed and second 
keyed in completely separate files. 

Continued on next page 
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Using EpiData for Data Entry, Continued 

 
Preparing for 
the second 
keying (cont.) 

Step Action 
1 Open EpiData and select "Prepare Double Entry Verification" 

from the Tools menu at the top of the screen. 
2 Select the original .rec file (e.g. survey.rec) that needs to be 

second keyed. 
3 Note that the name of the new data file for double entry has been 

automatically generated in the "File Name" field.  It has the same 
name as your original file except that "_dbl" has been added to 
the name. 

4 In the "Create Data File" dialog window, select the option "match 
records by field" in the lower left-hand corner.  Double click "ID" 
in the "Select key-field" dialog window. 

5 Click "OK" when the "Information" dialog window appears.  
Note that the name of the file for the second keying is listed at the 
bottom of this window again.  

 
Performing the 
Second Keying 

The table below provides step-by-step instructions on how to do the 2nd 
keying. 

 
Note: When the second keying is completed, the verified data will be stored 
in the _dbl.rec file, not the original .rec file. 

Step Action 
1 Open EpiData and click on the '4. Enter Data' button at the top of 

the screen. 
2 Select the _dbl.rec file created following the instructions above.  

A dialog window should appear over the data entry screen stating 
that you are in data entry verification mode.  The window will 
state which data file you are comparing with and which field is 
used to match records in each file (i.e. ID).  Click "OK". 

3 Complete the second keying in the same manner as the first 
keying, starting with the first instrument in your pile and using the 
TAB key to move between fields when entering data (refer to 
steps 3-6 from the instructions for first keying). 

4 If a value entered does not match with the first keying, follow the 
guidelines on the next page. 

5 Move completed instruments to the "completed" folder and 
update the Data Entry Tracking Form. 

6 Continue second keying instruments until all instruments in the 
"second key" folder have been entered and moved to the 
"completed" folder. 

Continued on next page 
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Using EpiData for Data Entry, Continued 

 
Validation and 
error 
correction 

During second keying, if there are any discrepancies between the data from 
the first keying and data from the second keying, the EpiData will 
immediately highlight the data that does not match.  Follow the guidelines 
below on what to do when discrepancies arise. 

 
If… Then… By… 

An error is found in the 
second keying. 

Keep the original 
value and continue. 

Clicking '3. Original' 
on data entry screen. 

An error is found in the 
first keying and is a 
minor typing error. 

Keep the new value 
and continue. 

Clicking '2. New' on 
data entry screen. 

Neither the first nor 
second keying is 
correct. 

Correct the error and 
continue. 

Clicking '1. Edit' on 
data entry screen. 

You are not sure which 
interpretation of the 
participant’s response 
is correct. 

Notify the supervisor 
and log any decision 
in the Data Entry 
Tracking Form. 

 

A high number of 
errors are found in the 
first keying. 

Notify the supervisor.  
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Consistency Reports 

 
Introduction At the end of each week, each data entry staff member entering data should run 

a consistency report on the survey.rec file on their computer to check the data 
for:   
 
• missing data for Participant ID 
• missing data for Cluster ID (I1) 
• missing data for date of interview (I4) 
• missing data for sex (C1) 
• missing data for age (C2 or C3). 

 
Instructions In EpiData there is a consistency check file that searches for problematic 

records and provides the Participant ID (PID) (or record number for those 
records missing PID) for each record that fails the check.  Follow the steps 
elow to create a consistency report. b 

Step Action 
1 Open EpiData. 
2 Select "Consistency Checks" from the "Document" menu at the top 

of the screen. 
3 Select survey.rec (or survey_dbl.rec if second keying has been 

completed) for "data file to check". 
4 Select consistency.chk for the "file containing checks". 
5 Click "OK". 
6 Save report under C:/STEPS/data/reports and use the current date 

as the file name. 
7 Print a copy of the report for your supervisor. 
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Backing up Data 

 
Introduction All data files must be backed up on a daily basis to avoid data loss.  

 
Backup At the end of each day of data entry you must backup all your data files.  This 

is to avoid data loss.  Follow the steps below to back up the files 
electronically using EpiData: 

 
Step Action 

1 Open EpiData. 
2 Select "Backup" from the "Data in/out" menu at the top of the 

screen. 
3 Select a .rec file that was used during the day for the "data file to 

backup" field. 
4 Type "D:\STEPS" in "destination directory" (or name of backup 

directory, see Part 2, Section 4). 
5 Click "OK". 
6 Repeat steps 1-4 until all .rec files used on your computer have 

been backed up. 
 

Note: Electronically backing up the data should be enough, however if your 
computers are not in a safe environment and you need to have another copy 
offsite, create a copy of the main STEPS folder for each machine on a disk at 
least once a week. 
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Pilot Test 

 
Introduction After data entry staff have been given a brief introduction to EpiData, a pilot 

test should be done to practice the entire data entry process. 

 
Test Data Test data will need to be generated for the pilot test.  If possible, the 

instruments completed by data collection staff during their training can be 
used.  Otherwise, the data entry supervisor should fill in enough instruments 
so that each data entry staff member has several instruments to enter.   
 
Additionally, Interview Tracking Forms should be generated for the pilot test.  
These should contain the same Participant IDs as are on the instruments used 
for the pilot test in order to properly simulate actual data collection forms. 

 
Procedure The table below summarizes all aspects of the data entry process that should be 

horoughly tested during the pilot test. t 

Step Action 
1 Create a full set of data collection forms including: 

• Interview Tracking Forms 
• 10-20 site-specific instruments 
• if Step 3 data is collected separately: Step 3 data collection forms.

 
Include some errors in these forms, e.g.: 
• torn pages 
• incorrectly filled out instruments 
• out-of-range responses 
• non-existent clusters 
• invalid participant ID and cluster numbers. 

2 Test all logging and sorting processes. 
• Use the Data Entry Log to sort and distribute all instruments. 
• Use the Data Entry Tracking Form to document data entry. 

3 Test all error correction systems including: 
• documentation 
• creating and reading consistency reports 
• backing up data 
• data recovery. 

4 At each step, report errors to the supervisor and refine the original 
EpiData template and instructions for handling different scenarios. 

5 When testing is complete and error free, delete all test materials 
from the computers and replace them with new copies of the 
finalized data entry files. 
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Section 6: Data Analysis Guide 

Overview 

 
Introduction This section provides general guidelines for the data analyst as well as a basic 

introduction to Epi Info.  For more specific instructions on how to proceed 
with the analysis of your STEPS data, see Part 4, Section 2. 

 
Intended 
audience 

This section is designed for use by those fulfilling the following roles: 
 
• data analyst 
• STEPS Site Coordinator 
• statistical adviser. 

 
In this section This section covers the following topics: 
 

Topic See Page 
General Information 3-6-3
Introduction to Epi Info 3-6-4
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Overview 

 
Introduction The data analyst is responsible for : 

 
• creating the database 
• cleaning and weighting the data 
• producing the completed fact sheet and data book. 

 
What you will 
learn 

In this course you will learn how to setup and use Epi Info to analyse your 
STEPS survey data. 

 
Learning 
outcomes  

The learning outcomes of this section are to be able to: 
 
• navigate the Epi Info Analysis module 
• run basic commands in Epi Info Analysis 
• run the generic analysis programs provided by the Geneva STEPS team. 
 
The generic analysis programs perform basic calculations needed to complete 
the Fact Sheet, Data Book, and site report. 

 
Other data 
analyst 
materials 

This guide is to be used in conjunction with the following sections in the 
STEPS surveillance manual.  These sections provide full background detail 
and instructional material on the following topics. 

 
Topic Part, Section 

Preparing the Sample Part 2, Section 2 
Preparing the Data Analysis Environment Part 2, Section 5 
Data Analysis Part 4, Section 3 
Fact Sheet Analysis Guide Part 6, Section 3B 
Data Book Template Part 6, Section 3D 
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General Information 

 
Introduction It is important that the data analyst has some background information on the 

STEPS survey as this may impact the way they analyse the data.  The general 
information that the analyst needs and where they can find this information is 
described below. 

 
Scope of survey The scope of the survey should be available in the implementation plan.  The 

STEPS Site Coordinator will also have this information.  The data analyst 
must understand the scope of the survey so that the results of the analysis 
reflect the scope. 

 
Sample method It is essential that the data analyst understands what sampling method was 

used for the STEPS survey so that the data can be properly weighted.  The 
analyst should be familiar with the Interview Tracking Form Excel workbook 
(interview_tracking_form.xls) and the STEPS sampling Excel workbook 
(STEPSsampling.xls).   
 
The sampling information should already be documented in the STEPS 
Implementation Plan and/or supporting documents and available for the 
analyst.  If it is not documented, consult the STEPS Site Coordinator and 
make sure the information is documented right away.  It is critical 
information and needs to be documented. 

 
Assisting with 
fact sheet and 
site report 

The data analyst should also assist the Site Coordinator with the Fact Sheet 
and site report.  Liaise with the Site Coordinator to identify the data analyst's 
roles and responsibilities, see Part 4, Section 4 for more information.  
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Introduction to Epi Info 

 
Introduction For the analysis of data, the STEPS team recommends and supports Epi Info, 

a purpose-built, free, public-domain software package.  While Epi Info has a 
broader range of functions, this manual will only explain how to perform data 
analysis in Epi Info using the Analysis module in Epi Info. 

 
Rationale The decision for choosing Epi Info was made in light of its advantages, some 

of which are listed below. 
 

• Windows-based 
• recent release of Epi Info, supported by developers 
• has data analysis capability in line with STEPS requirements 
• can appropriately adjust for complex sampling designs. 

 
Topics covered The following topics are covered in this tour of Epi Info: 

 

• basic terminology 
• opening the Analysis module and Analysis module screen components 
• software settings and basic commands 
• creating a new or derived variable 
• displaying a variable 
• obtaining basic descriptive statistics on a variable 
• recoding a variable 
• displaying data in a graph 
• running saved programs 
• selecting a subset of records in a dataset 
• saving and printing outputs. 

 
Downloading & 
Installing Epi 
Info 

For instructions on downloading and installing Epi Info, please see Part 2, 
Section 5, Preparing the Data Analysis Environment. 

Continued on next page 
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Introduction to Epi Info, Continued 

 
Terminology Some of the specific Epi Info terms used are described in the table below. 

Term Description 
Command Predefined term in Epi Info syntax (language) that tells 

Epi Info how to manipulate or analyse your data (e.g. 
LIST, SELECT). 

Program (.pgm) Syntax files that can be saved in a separate text file or 
within an Access database.  Contain a series of 
commands in Epi Info syntax to manipulate and analyse 
data. 

Project The name of the actual Access database (.mdb) file. All 
the data and related programs are stored within the 
project. 

Variable Any characteristic or attribute that can be measured.  
For STEPS datasets, most variables correspond to one 
question on the Instrument.  

 
To open Epi 
Info 

To open the Epi Info Analysis module double click on the Epi Info icon on 
your desktop and click the "Analyze Data" button in the lower left-hand 
section of the screen.   
 
Alternatively, you can open the Analysis module directly by navigating to 
your Epi Info program folder (e.g. C:\Epi_Info) and double-clicking on the 
"analysis.exe" file. 

 
Screen 
Components 

The Analysis module of Epi Info has three main components divided into the 
following three windows: 

 
Window Function 

Analysis Contains all the commands that can be used during 
analysis. 

Analysis Output Displays the results of a program once it has been run. 
Program Editor Displays the code of saved programs and can be used to 

write new programs. 

Continued on next page 
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Introduction to Epi Info, Continued 

 
Software 
Settings 

Follow the steps below to set Epi Info to exclude missing data and to provide 
the appropriate output for weighted analyses. 

 
Step Action 

1 In the Analysis window, click on Analysis Commands> 
Options>Set.  It is located at the very bottom the Analysis window. 

2 In the SET window, set "Yes as" to "Yes", "No as" to "No", and 
"Missing as" to "Missing. 

3 Ensure all 6 check boxes immediately beneath the "Yes as" drop-
down box are checked. 

4 Set "Statistics" to "Advanced". 
5 Ensure the check box for "Include missing" is NOT checked. 
6 Set "Process records" to "Normal (undeleted)". 
7 Click "Save all". 

 
Open a dataset Follow the steps below to open a dataset that is stored as a data table within 

an Access database. 
 

Step Action 
1 In the Analysis window, click on Analysis Commands>Data> 

Read (Import) to open the READ window. 
2 Set the "Data format" to "Epi 2000". 
3 Click on "Change Project" and find and select your Access .mdb 

file (e.g. STEPS.mdb). 
4 Click on the name of your dataset (e.g. MasterDataSet) from those 

listed. 
5 Click "OK". 

 
Note:  The file path, number of records and date/time will be displayed in the 
Analysis Output window once the dataset is opened. 

Continued on next page 
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Introduction to Epi Info, Continued 

 
Create a new or 
derived 
variable 

Follow the steps below to create and assign values to a new or derived 
variable (e.g. BMI). 
 

Step Action 
1 In the Analysis window, click on Analysis Commands>Variables> 

Define to open the DEFINE window. 
2 In the DEFINE window, type the name of your new variable in the 

space provided (e.g. BMI). 
3 Ensure "Scope" is set to Standard and click "OK". 
4 In the Analysis window, click on Analysis Commands>Variables> 

Assign to open the ASSIGN window. 
5 In the "Assign Variable" field, select your newly defined variable 

(e.g. BMI) from the drop-down list. 
6 In the "Expression" field type the formula to compute the values of 

your new variable (e.g. weight/height*height).  To use existing 
variables (e.g. weight and height) in your formula, select them 
from the "Available Variable" drop-down list.  

7 Click "OK".  

 
List all variable 
values 

Follow the steps below to list the value of a variable for all records in the 
analysis output. 
 

Step Action 
1 In the Analysis window, click on Analysis Commands>Statistics> 

List to open the LIST window. 
2 Choose the variable(s) you wish to list from the "Variables" drop-

down list or click the check box "All (*) Except" to list all 
variables. 

3 Click "OK".  A list of the chosen variables will be displayed in the 
Analysis Output window.  

 
Create a 
frequency table 
for a variable 

Follow the steps below to create a frequency table for a variable containing a 
list of all values for a given variable and the frequency of each value. 
 

Step Action 
1 In the Analysis window, click on Analysis Commands>Statistics> 

Frequencies to open the FREQ window. 
2 Choose the variable(s) you wish to list from the "Frequency of" 

drop-down list (select * to list all variables). 
3 Click "OK".  A frequency table(s) will be displayed in the Analysis 

Output window.  
 

Continued on next page 
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Introduction to Epi Info, Continued 

 
Create a means 
analysis for a 
variable 

Follow the steps below to perform a means analysis on a variable.  The output 
of this command provides a frequency table as well as the mean, variance, 
standard deviation, and quartile values for the variable. 
 

Step Action 
1 In the Analysis window, click on Analysis Commands>Statistics> 

Means to open the MEANS window. 
2 Choose the variable(s) you wish to list from the "Means of" drop-

down list (select * to list all variables). 
3 Click "OK".  A frequency table(s) and means analysis will be 

displayed in the Analysis Output window.  

 
Recode a 
variable  

Follow the steps below to recode a variable (e.g. age to Agerange). 
 

Step Action 
1 In the Analysis window, click on Analysis Commands>Variables> 

Recode to open the RECODE window. 
2 Select the variable from which you want to recode (e.g. age) from 

the "From" drop-down list. 
3 Select the variable to which you want to recode (e.g. Agerange) 

from the "To" drop-down list. 
4 Complete one line in the table for each value or range of values for 

your "From" variable that you wish to recode.  It is recommended 
that all possible values for the "From" variable are assigned a 
corresponding value in the "To" variable to avoid missing values in 
the "To" variable. 
 

Example: To recode age values of 25 to 34 to the Agerange value 
of "25-34", type 25 for "Value", type 34 for "To Value", and type 
25-34 for "Recode Value".  To create further values for Agerange 
(e.g. 35-44, 45-54), complete additional rows in the table as 
needed. 

5 Click "OK" when finished.  

 
Graph 
variables 

Follow the steps below to graph variables. 
 

Step Action 
1 In the Analysis window, click on Analysis Commands>Statistics> 

Graph to open the GRAPH window. 
2 Select "Graph type" from the drop-down list (e.g. bar for binary or 

points to depict continuous variables). 
3 In the "X axis" section, select the X axis variable from the "Main 

variable(s)" drop-down list. 
4 In the "Y axis" section, set "show value of" to "Count". 
5 Fill in labels and titles if desired and click "OK".  

Continued on next page 
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Introduction to Epi Info, Continued 

 
Run programs F ollow the steps below to run a saved program. 

Step Action 
1 In the Analysis window, click on Analysis Commands>User-

Defined Commands>Run Saved Program to open the RUNPGM 
window. 

2 Your program can either be stored in a program file (.pgm) or 
within an Access database file (.mdb).  The table below shows how 
to run a program depending on the type of file in which it is saved. 
 

Program (.pgm) file Access Database 
Step Action Step Action 
2.1a Click on the grey 

box to the right of 
the "Filename" field 
to search for your 
.pgm file. 

2.1b Click on the grey box to 
the right of the 
"Filename" field to 
search for your .mdb 
file. 

2.2a Set "Files of type" to 
.pgm. 

2.2b Set "Files of type" to 
.mdb. 

2.3a Once you have found 
your file, click "OK" 
in the RUNPGM 
window. 

2.3b Once you have found the 
database, select the 
program from the 
"Program" drop-down 
list and click "OK". 

  

 
Select a subset 
of a dataset 

Follow the steps below to select a subset of a dataset.  The SELECT 
ommand will stay in effect until another SELECT command is called. c 

Step Action 
1 In the Analysis window, click on Analysis Commands>Select/If 

>Select to open the SELECT window. 
2 Complete the "Select Criteria" field with the desired equation (e.g. 

C1=1), use the drop-down list in the "Available Variables" field to 
select variables in your dataset for your equation. 

3 When your equation is complete, click "OK". 
4 To cancel the SELECT command, open the SELECT window 

again and click "OK", leaving the "Select Criteria" field blank. 

Continued on next page 
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Introduction to Epi Info, Continued 

 
Save a dataset Follow the steps below to save a dataset after you have opened it and 

odified it. m 
Step Action 

1 In the Analysis window, click on Analysis Commands>Data> 
Write (Export) to open the WRITE window. 

2 Set "Output Mode" to "Replace". 
3 Click on the grey box next to the "File Name" field to search and 

select your data file (e.g. STEPS.mdb). 
4 Select the name of the data table to which you would like to write 

in the drop-down list (e.g. MasterDataSet) or write the name of a 
new table in the "Data Table" field. 

 
Save outputs F ollow the steps below to save the output in one file. 

Step Action 
1 In the Analysis window, click on Analysis Commands>Output> 

RouteOut to open the ROUTEOUT window. 
2 Define or browse for an output filename where your analysis is to 

be stored and click "OK". 

 
Print outputs Follow the steps below to print outputs. 

Step Action 
1 In the Analysis window, click on Analysis Commands>Output> 

PrintOut to open the RPRINTOUT window. 
2 Click "OK".  The results will be printed.  
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